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Administration in The Financial Edge contains utilities and housekeeping tools you can use to set up your 
database, establish system security, import records, globally change records, and post all or selected transactions 
to General Ledger. You can also view system statistics, check the database for duplicate records, and validate the 
database.
This chapter is designed to familiarize you with all of the administration utilities found The Financial Edge. 
Financial Edge programs include General Ledger, Accounts Payable, Accounts Receivable, Cash Receipts, Fixed 
Assets, and Student Billing. This chapter also includes information about accessing and navigating the 
Administration page.
For information about importing records, see the Import Guide for The Financial Edge. For information about 
Accounting Queue, see the Accounting Queue Guide. 

Navigating in Administration

The Administration page is the central location for accomplishing administrative tasks. Click Administration on 
the navigation bar to access the Administration page. Each task available in Administration appears as a link. The 
links available on the Administration page can vary depending on the program you have open. 

You move through the Administration page the same way you move through other areas of the program. To 
access the different utilities on the page you can click the links. Common areas include the menu bar and toolbar. 
For more information about the menu bar, toolbar, and program navigation, see the Program Basics chapter of 
the Program Basics Guide.

Note: Visit our website at www.blackbaud.com for the latest documentation and information.

Note: The Administration link does not appear on the navigation bar if a user does not have security rights to 
access Administration.
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Common Administrative Tasks
Using the maintenance tools available in Administration, you can perform a variety of administrative tasks, such 
as setting up system security, importing records, globally changing records, viewing system statistics, checking 
the database for duplicate records, and validating the database.
The tasks described in the this section are found in more than one program, while others are specific to one 
program. Detailed information and procedures for setting up security and globally changing records are found in 
separate chapters of this guide.

Setting Up Programs in The Financial Edge

Before you begin using General Ledger, Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, or 
Student Billing, you should first set up each program using the Set up link in Administration. The Set up page for 
each program contains a list of links to areas you should customize before beginning daily operations in The 
Financial Edge. To find more information about the set up task in which you are currently working, press F1 on 
your keyboard to access the help file.

Viewing System Statistics

Click the View system statistics link on the Administration page to view up-to-date totals of all your database 
records and details about certain system processes and activities. For example, statistics in General Ledger 
include the number of account records and the date of the last post and the user who performed the post.

 Viewing system statistics

Note: After you install or convert to The Financial Edge, we strongly recommend you set up each program 
using the Set up link in Administration before entering any data.

Note: Viewing system statistics is common to all programs. While this procedure is written specifically for 
viewing system statistics in General Ledger, the steps can be used for all programs.
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1. From the Administration page in General Ledger, click View system statistics. The View system statistics
screen appears displaying up-to-date statistics about the records, processes, and activities in your
database.

2. To return to the Administration page, click Administration on the navigation bar or click Back.

Posting from The Financial Edge Subsidiary Ledgers to 
General Ledger

Posting from subsidiary ledgers in The Financial Edge to General Ledger is essentially the same process as posting 
from General Ledger using the Other Blackbaud Systems tab. The differences are that (1) from General Ledger, 
you can post from multiple subsidiary ledgers at once and (2) from a subsidiary ledger program, you can save and 
manage post parameter files to re-use when posting, so you do not have to define post parameters each time you 
post. You can post transactions alone or simultaneously with other applications, such as the optional module 
Purchase Orders. You can select to run pre-post reports to verify batches before posting.
You can also create and use post parameter files in queues if you have the optional module Accounting Queue. 
For more information about queues, see the Accounting Queue Guide.

Posting batches from subsidiary ledgers in The Financial Edge 

Note: A subsidiary ledger is a record of the original financial transactions that in total equal the balance of a 
control account in the general ledger. Subsidiary ledgers in The Financial Edge include Accounts Payable, 
Accounts Receivable, Cash Receipts, Fixed Assets, and Student Billing.

Note: All other users should exit the system while you post or validate. If any transactions you are attempting 
to post are open by another user, a message appears and the post or validation process is canceled.
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1. From the Administration page in Accounts Payable, click Post. The Post page appears.

2. If any post parameter files have been saved, they appear in the list. You can either open one of the saved
files or create a new file. To create a new post parameter file, click New Post Parameter on the action
bar.

3. The New Post Parameter screen appears displaying the General tab.

4. Mark the Post Accounts Payable transactions with this journal code checkbox and select a journal code.
5. If you have the optional module Purchase Orders and you want to post purchase orders, mark Post

Purchase Orders transactions with this journal code and select a journal code.

6. To create an export file, mark Create an output file of posted transactions in this format and select a file
format. In the Export file name field, enter an export file name or click the ellipsis to browse.

7. On the General tab, you can also customize journal reference formats for debits and credits for each
transaction type. In the box on the left, select the transaction type. A grid for the transaction type
appears on the right. In the Reference Type column, select Custom. Enter the format in the Journal
Reference column. You can select <Default> in the Reference Type column to return to the default
format.

Note: While this procedure demonstrates how to post from Accounts Payable, the process is essentially the 
same for Accounts Receivable, Cash Receipts, Fixed Assets, and Student Billing.

Note: Even if you create an export file, the program posts the information directly to General Ledger.
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8. If you want to post selected transactions, select the Filters tab. 

9. In the Post date field of the Include transactions with post dates in this date range frame, you can select 
a specific date or date range of posted transactions to include. If you select “<Specific range>”, you can 
specify a start date and an end date. 
If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all 
activity from the start date until present is included. If both fields are blank, all activity is included.

10. In the Include transactions with document dates in this range frame, select a date or date range in the 
Document date field. If you select “<Specific range>”, you can specify a start date and an end date. 

11. To filter transactions by record type, choose “Selected” in the Include column for each filter type. The 
selection screen appears for you to designate specific filters. Make your selections and click OK. You 
return to the Filters tab.

Note: For some record types, you can also filter by a range or query.
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12. To define how the batch validation and post report appear, select the Format tab.

13. In the first field, select “Use the default Post Report parameters”, “Always ask for a parameter file”, or 
“Always use this parameter file”. 
• If you select “Use the default Post Report parameters”, the program uses the Post Report parameters 

established on the Post Options link of the Records Options tab for General Ledger.
• If you select “Always ask for a parameter file”, you are prompted to select a parameter file each time 

you post. The Select a Parameter File screen appears listing saved parameter files. You can select to 
use a saved parameter file or create a new one. 

• If you select “Always use this parameter file”, designate a parameter file to use as the default each 
time you post. The first time you select this option, the Select a Parameter File screen appears. On this 
screen, you can select a saved parameter file, add a new one, open a parameter file to edit, or find a 
parameter file by file name, description, user created by, or date created on.

14. In the next field, select to preview or print the post report. If you select to print the report, designate a 
printer.

15. To print a control report, mark Print control report on and select a printer.
16. Click Save and Close. The Save Post as screen appears.
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17. Enter a name and description for the post parameter file. Mark checkboxes to determine if other users
can run or modify the post. Click Save. You return to the Post page in Administration.

18. To print a Batch Validation Report to review before posting, select the parameter file and click Preview
on the action bar. When the processing finishes, a validation successful message appears. Click OK and
the Batch Validation Report appears.

19. To post, select the parameter file to use and click Post on the action bar.
20. When the processing finishes, a post successful message appears. Click OK.

Importing Records

Importing records is the process in which you move data from other programs into The Financial Edge. Instead of 
opening a new or existing record and adding information, you place the information in an import file and use 
Import records to create new records automatically or update existing records. 
Importing records is particularly useful if your organization maintains multiple databases or if you need to 
combine two or more databases into one.
For more information about importing records, see the Import Guide for The Financial Edge.

Globally Changing Records

By globally changing data, you can change information in your database based on a group of records you specify. 
Using Globally change records, you can add, delete, copy, move, swap, replace, partially replace, increase, or 
decrease values in a field you select. 
In General Ledger, you can globally change fields for project, account, and transaction records. In Accounts 
Payable, you can globally change fields for products, vendors, invoices, credit memos, recurring invoices, 
purchase orders, receipts, and bank adjustments. In Accounts Receivable, you can globally change records for 
products and billing items, clients, charges, credits, invoices and invoice line items, refunds, return and return line 
items, recurring invoices and recurring invoice line items, and payments. You can globally change fields for assets 
and transactions in Fixed Assets. In Student Billing, you can globally changes fields for products and billing 
items, individuals, organizations, students, charges, credits, refunds, advance deposits, financial aid, and billing 
schedules. After entering the global change information, you can save it in a parameter file. You can then run 
the same global change again later, or modify it and run it.
For more information about globally changing records, see “Global Change” on page 113.

Note: We recommend you review a Batch Validation Report before posting.
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Searching for Duplicate Records

Using Search for duplicates, you can view duplicate criteria and report on duplicate records. You can search for 
duplicate projects in General Ledger, if you have the optional module Projects and Grants; duplicate vendors in 
Accounts Payable; duplicate clients in Accounts Receivable; duplicate assets in Fixed Assets; and duplicate 
students, individuals, and organizations in Student Billing.

The criteria used when searching for duplicate records is defined in Business Rules of Configuration. For more 
information about defining criteria, see the Configuration Guide for the respective program.

Searching for duplicate project records
While this procedure explains how to search for duplicates in General Ledger, you can use the same steps in 
any program.
1. From the Administration page in General Ledger, click Search for duplicates. The Duplicate Project

Report screen appears.
On this screen you can view the duplicate project criteria defined in Configuration. This criteria can be
changed only on the project business rules screen.

The Field Name and Length columns contain duplicate criteria defined in Configuration. You can change 
this information on the Business Rules page.

2. To create a query of all duplicate project records, mark Create output query of duplicate records. Once
you create an output query, you can access it later in other areas of the program.

3. To preview the report, click Preview. A processing screen appears.
4. If you marked Create output query of duplicate records, the Save Static Query screen appears. If you did

not create an output query, proceed to step 5.

Note: You can also search for duplicate records from an open record.

Note: You must have the appropriate security rights to search for duplicates by Social Security number. For 
more information, see the Security chapter of the Administration Guide for The Financial Edge.
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a. Enter a name and description and designate whether others can run and modify this query by 
marking the corresponding checkboxes. 

b. To save the query, click Save. If duplicate project records exist, the Duplicate Project Report screen 
appears displaying a preview of the report.

5. You can print, refresh, or send the report as email by clicking the corresponding buttons on the toolbar. 
6. To close the preview and return to the Duplicate Project Report screen, click the red X.

Accounting Queue

Using the optional module Accounting Queue, you can schedule a sequence of tasks to run automatically and 
unattended. You can schedule the program to handle these time-consuming tasks overnight or while you are at 
lunch. Scheduling queues during non-working hours frees your critical resources — workstations and printers —  
for other tasks during normal working hours. 
For more information about using Accounting Queue, see the Accounting Queue Guide.

Security Settings

By establishing security rights for your users, you can ensure the validity, consistency, and confidentiality of your 
data and determine which users can change or delete important records. By limiting viewing rights, you can 
control who sees sensitive information.
You can access security from Set up system security on the Administration page of any program.
Defining security rights for accessing Administration and using administrative tools is important for protecting the 
integrity of your data. The system administrator or supervisor in charge of setting security privileges should 
assign security rights to users based on specific job requirements. You can control rights to each task available in 
Administration. For more information about security rights, see “Security” on page 131.

Validating Your Database

We recommend validating your database on a regular basis. During the validation process, the program scans 
your database tables to determine if data corruption or inconsistencies are present. Errors may occur when 
software packages or operating systems corrupt your computer’s memory, or hardware problems corrupt the 
database file.
As a precaution, we recommend running a backup before validating your database. All users must be logged out 
of the database prior to starting the validation. Because the process can take several hours, we recommend you 
run it after business hours. Using the delay feature, you can set the start time for the validation to run.

Note: Before you validate your database, we recommend you run a backup.
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Validating your database
1. From the Administration page in any program, click Validate database. The Database Validation screen 

appears.

2. To delay the validate database process to a specific time, mark the Delay the validation start time until 
checkbox and enter a time in the field. Do not mark this option if you want to validate your database 
immediately.

3. Click Continue. A confirmation screen appears.
4. If you are sure you want to continue, click Yes. 

If you delayed validation until a specified time, the countdown screen appears displaying the current time 
and the time scheduled for validation.

When the validation process begins, a processing screen appears.

When processing is complete, a screen appears informing you that the program has finished validating 
your database. It also displays the elapsed time of the validation process.

5. To return to the Administration page, click OK.

Note: To begin the validation process from the countdown screen regardless of the specified time, click Start 
Now.

Note: If an error occurs, contact Blackbaud’s Customer Support for assistance.
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Creating Consolidation Export Files

Consolidation Management is an optional module intended for use by organizations with multiple companies and 
enables you to generate reports containing consolidated activity for all subsidiaries that are part of a 
multi-company organization.
To generate consolidated reports, you first need to send account setup information and activity from your 
subsidiary ledgers to the consolidation database. To do this, you create export files containing account setup 
information and activity. The export files you create are always Microsoft Access Database files (.mdb).
If you have the optional module Consolidation Management, a Create consolidation export file link appears on 
the Administration page. Use this link to create export files from the Administration page of your subsidiary 
General Ledger databases. Once created, access the General Ledger consolidation database and import the files. 
There are two types of subsidiary export files used in Consolidation Management: account setup and account 
activity.
For more information about Consolidation Management and creating consolidation export files, see the 
Consolidation Management Guide.

Electronic Signatures

Electronic signatures are scanned bitmap (*.bmp) images that can be used on Accounts Payable checks and 
purchase orders, Accounts Receivable receipts, Cash Receipts, and Student Billing receipts. In Administration 
in Accounts Payable, Accounts Receivable, Cash Receipts, and Student Billing. you can add a new signature or 
open, edit, and delete existing signatures. Electronic signature bitmaps can be saved in the database or 
created with a file path to a specified location.

 Creating an electronic signature
1. From Administration page in Accounts Payable, Accounts Receipts, Cash Receipts, or Student

Billing, click Electronic Signatures. The Electronic Signatures screen appears.

Note: A bitmap is a scanned image. These images are saved with the *.bmp file name.

Note: Graphic images for electronic signatures must be in bitmap (*.bmp) format and no larger than 0.25 inch 
high and 2.25 inches wide. The program automatically sizes images to fit in the check or purchase order’s 
allotted space.
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2. Click New Signature. The New Electronic Signature screen appears.

3. In the Description field, enter a description of the signature. For example, “CEO Signature”.

4. In the Status field, select “Active”. 
5. In the Signature file name field, enter the file path to the bitmap or click the ellipsis button to search by 

file name and select the scanned signature. 
6. Once a signature file name is selected, the image will appear in the Signature as it will appear box. Check 

this image to verify that you have the correct signature.
7. In the Include on box, mark the checkboxes for the checks or purchase orders you want the signature to 

appear on.

Note: If you select “Inactive” in the Status field, a file for the electronic signature is saved and appears on the 
Electronic Signatures screen. However, you cannot use the signature unless its status is changed to active.
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8. To save and close the New Electronic Signature screen, click OK. The Electronic Signatures Screen appears
displaying the new electronic signature and its settings.

9. To return to the Administration page, click Close.
10. If you have the optional module Advanced Security, you can set user rights to electronic signatures. For

more information about security users, see “Security for Users” on page 150.

General Ledger Administration
Tasks that appear on the Administration page only in General Ledger include summarizing, purging, and closing 
fiscal years, entering and locking beginning balances, and updating fund transaction requirements. When posting 
to General Ledger from the Administration page in General Ledger, you can post batches and post from multiple 
subsidiary ledgers at once.

Posting in General Ledger

Posting a batch adds transaction entries to ledger accounts and updates account balances. You can post batches 
from Journal Entry or Administration in General Ledger, or from Administration in Accounts Payable, Accounts 
Receivable, Cash Receipts, Fixed Assets, or Student Billing.
In General Ledger, when posting through Journal Entry, you can post only one batch of transactions at a time. 
However, when posting through Administration, you can post multiple batches at the same time.

Note: Electronic signatures can also be edited from the Administrative tasks link in Banks.

Note: A post is the process of transferring transaction amounts from a journal to general ledger accounts and 
updating account balances. Posting commits transactions to the account record.

Note: A batch is a group of debit and credit transactions you can post to your ledger accounts. By placing 
transactions into a batch, you can group transactions according to source, date, time, and function.
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By selecting the Post link in Administration for General Ledger, Accounts Payable, Accounts Receivable, Cash 
Receipts, Fixed Assets, or Student Billing, you can post all or selected transactions to General Ledger. You 
can also post Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, or Student Billing, 
transactions alone or simultaneously with other applications, such as the optional module Purchase Orders.

Batch Validation Requirements

The primary function of the batch validation process is to make sure batches are in balance. When the validation 
process is initiated, the program reviews each transaction to ensure all required fields are entered and each entry 
meets certain requirements. In most instances, individual transactions and account information entered into 
The Financial Edge will be validated individually upon data entry. However, you can use the validation process to 
confirm that batches are in balance by each required factor.

Balancing Requirements

You can post only a balanced batch to General Ledger. Validating a batch verifies the batch is in balance by these 
factors: 
• Fund - A batch must be in balance by fund.
• Period - Debit and credit transactions must balance by accounting period. Periods used on transactions may

not be closed.
• Amount - The total of all debit transactions must equal the total of all credit transactions.
• By period within fund - Batches which contain transactions for more than one period will be checked to make

sure the debit and credits within each fund are in balance for each period.
• Journal - Transactions must balance by journal reference value.
• Projects -  If you are using the optional module Projects, you may have to balance by project if Require to

Balance is marked for the related fund.
• Segment - You may have to balance by segment if Require to Balance is marked for the related fund.
• Class - You may have to balance by class if Require to Balance is marked for the related fund.
• Transaction codes - You may have to balance by transaction codes if Require to Balance is marked for the

related fund.
• Type - A batch must balance by regular or encumbrance type.
Validation checks the status of accounts and projects in the batch. They must be marked as active. To change the 
account or project status, select the line in the batch record. From the Batch menu, select Go to and Account or 
Project. The record opens and you can make the necessary changes.

Validating and Posting Regular Batches in General Ledger
Using the Post link in Administration in General Ledger, you can post two kinds of transaction batches: regular 
batches and batches from subsidiary ledgers in The Financial Edge. For information about posting batches from 
subsidiary ledgers, see “Posting From Other Blackbaud Systems” on page 17 and “Posting from The Financial Edge 
Subsidiary Ledgers to General Ledger” on page 4.

Note: Batch validation is a process used to make sure your batches are in balance before posting. The program 
looks at each transaction to ensure that all required fields are entered and that each entry meets program and 
user-specified requirements.

Note:  You can run the batch validation process without posting.
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Validating and posting a regular batch in General Ledger

1. From the Administration page in General Ledger, click Post. The General Ledger Post screen appears on 
the Regular Batches tab.

2. By default, the grid displays only open batches with zero balances. To show all open batches regardless of 
balance amount, unmark the Only show zero balances checkbox.

3. Mark the Post checkbox for each batch you want to validate and post.

4. In the Post Options frame, select “Validate and post” for the selected batches.
5. To receive a confirmation message after each selected batch is validated, mark Confirm validation after 

each batch. With this feature, you determine whether to post or skip a batch during processing.

6. Select whether to print or preview the Batch Validation Report. If you select “Print report on”, select a 
printer. 

7. To print a Post Control Report after the posting process, mark Print control report on and select a 
printer.

8. To begin the validation process, click Process Now. A processing screen appears. If you marked Confirm 
validation after each batch on the previous General Ledger Post screen, a message appears for each 
batch telling you if the batch was valid or not. You can cancel or continue processing each batch that does 
not validate. 

Note: All other users must exit the system while you post or validate. If any users are logged in, a message 
appears and the post or validation process is canceled.

Note: Select “Validate only” in the Post Options frame to validate without posting.

Note: In Journal Entry Post Options, you control the parameters to use for the reports. For more information, 
see the Options chapter of the Program Basics Guide.



A D M I N I ST RA T I O N 17
When all batches have processed, the Post screen appears displaying the number of batches posted and 
the number that failed validation.

9. To exit the Post screen and return to the General Ledger Post screen, click Close.

Posting From Other Blackbaud Systems

Using the Post link in Administration in General Ledger, you can post two kinds of transaction batches: regular 
batches and batches from subsidiary ledgers in The Financial Edge. Subsidiary ledgers in The Financial Edge 
include Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, and Student Billing.
You cannot post the 6.x subsidiary ledgers, Student Billing from General Ledger. All 6.x subsidiary ledgers must 
be posted from Utilities and Housekeeping in the subsidiary program.
To post batches from subsidiary ledgers in The Financial Edge, from General Ledger, select the Other Blackbaud 
Systems tab on the General Ledger Post screen. You can select to post from multiple programs, and select to use 
saved parameter files or to define parameters as you proceed.

If defining parameters as you proceed, you make selections and enter information related to each subsidiary 
ledger on three tabs on the Post to General Ledger screen: General, Filters, and Format. These tabs help you 
select information specific to each subsidiary ledger in The Financial Edge to be posted to General Ledger. For 
example, on the General tab of Accounts Payable, you can specify the journal reference to use for each type of 
transaction. Keep in mind that journal references, options, fields, and other selections for each tab on the Post to 
General Ledger screen vary from one program to another in The Financial Edge.

General tab. On the General tab, you select journal codes and journal references for the transactions you want 
to post. Journal codes are defined in Configuration in General Ledger. A grid displays default journal 
references for each transaction type. Journal references are defined on the Posting Information link of 
Configuration in Accounts Payable, Accounts Receivable, Cash Receipts, Fixed Assets, and Student Billing. 
On the General tab, you can select Custom in the Reference Type column to enter a different journal 
reference.

Filters tab. On the Filters tab, you include transactions to be posted based on selected criteria. You can filter by 
post date or document date. You can also filter by record type and include all or selected records.

Format tab. On the Format tab you select parameters and printing options for the Batch Validation Report and 
Post Control Report.

Note: A subsidiary ledger is a record of the original financial transactions that in total equal the balance of a 
control account in the general ledger.

Note: From Administration in Financial Edge subsidiary ledgers, you can save post parameter files. For more 
information, see “Posting from The Financial Edge Subsidiary Ledgers to General Ledger” on page 4.

Note: A journal code indicates the source of a transaction. These codes are maintained on the Tables tab and 
enabled on the Business Rules tab of Configuration in General Ledger. You can filter many reports by journal 
code.



18 CH A PT E R  
Posting a batch from another Blackbaud system

1. From the Administration page in General Ledger, click Post. The General Ledger Post screen appears.

2. Select the Other Blackbaud Systems tab.

3. In the Post column, mark the checkbox for each The Financial Edge subsidiary ledger from which you 
want to post. For example, mark the box for Accounts Payable.

4. In the Post Parameters column, you can select a saved post parameter file defined on the Post link in 
Administration for each program, or select “<Define Post Parameters>” to define the parameters as you 
continue in this procedure.

Note: All other users must exit the system while you post or validate. If any user is logged in, a message 
appears and the post or validation process is canceled.

Note: While this procedure demonstrates how to post Accounts Payable transactions from the Other 
Blackbaud Systems tab, the steps can be used as a model for all subsidiaries in The Financial Edge.
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5. Click Process Now. If you selected pre-defined post parameter files, the processing begins immediately. If 
you selected to define post parameters, the Post to General Ledger screen appears.

6. Mark the Post Accounts Payable transactions with this journal code checkbox and select a journal code.
7. If you have the optional module Purchase Orders and you want to post purchase orders, mark Post 

Purchase Orders transactions with this journal code and select a journal code.

8. To create an export file, mark Create an output file of posted transactions in this format and select a file 
format. In the Export file name field, enter an export file name or click the ellipsis to browse.

9. On the General tab, you can also customize journal reference formats for debits and credits for each 
transaction type. In the box on the left, select the transaction type. A grid for the transaction type 
appears on the right. In the Reference Type column, select Custom. Enter the format in the Journal 
Reference column. You can select <Default> in the Reference Type column to return to the default 
format.

Note: You must complete the Post to General Ledger screens for each program you selected to post and to 
define post parameters.

Note: Even if you create an export file, the program posts the information directly to General Ledger.
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10. Select the Filters tab. 

11. In the Post Date field of the Include transactions with post dates in this date range frame, you can select 
a specific date or date range of posted transactions to include. If you select “<Specific range>”, you can 
specify a start date and an end date.
If the Start date field is blank, all activity is included up to the end date. If the End date field is blank, all 
activity from the start date forward, including transaction with a future post date, is included. If both 
fields are blank, all activity is included.

12. In the Include transactions with document dates in this range frame, select a date or date range in the 
Document date field. If you select “<Specific range>”, you can specify a start date and an end date. 

13. To filter transactions by record type, choose “Selected” in the Include column for each filter type. The 
selected <Filter> screen appears for you to designate specific filters. Make your selections and click OK. 
You return to the Filters tab.
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14. Select the Format tab.

15. In the first field, select “Use the default Post Report parameters”, “Always ask for a parameter file”, or 
“Always use this parameter file”. 
• If you select “Use the default Post Report parameters”, the program uses the Post Report parameters 

established on the Post Options panel of the Records Options tab for General Ledger.
• If you select “Always ask for a parameter file”, you are prompted to select a parameter file each time 

you post. The Select a Parameter File screen appears listing saved parameter files. You can select to 
use a saved parameter file or create a new one. 

• If you select “Always use this parameter file”, designate a parameter file to use as the default each 
time you post. The first time you select this option, the Select a Parameter File screen appears. On this 
screen, you can select a saved parameter file, add a new one, open a parameter file to edit, or find a 
parameter file by file name, description, user created by, or date created on.

16. In the next field, select to preview or print the post report. If you select to print the report, designate a 
printer.

17. To print a control report, mark Print control report on and select a printer.

18. To print a Batch Validation Report to review before posting, click Pre-Post Report. When the processing 
finishes, a validation successful message appears. Click OK and the Batch Validation Report appears.

19. To begin the posting process, click Post Now.
20. When the processing finishes, a post successful message appears. Click OK.

Fiscal Year-End Procedures

Fiscal year-end procedures include processes and information for pre-closing, closing, summarizing, and purging 
fiscal years in General Ledger.

Note: We recommend you review a Batch Validation Report before posting.
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Pre-Closing and Closing Fiscal Years

The purpose of closing a fiscal year is to update the net asset accounts in the balance sheet with income 
statement activity. At the end of the year, General Ledger adds all income statement transactions together to 
calculate the net surplus/deficit for the year. It then “zeros” income statement account balances by transferring 
the net surplus or deficit to the appropriate net asset accounts. In balance sheet accounts, ending balances roll 
forward to the next fiscal year.
You can also pre-close a fiscal year. A pre-closing is a mock closing that can be used to temporarily close a year in 
order to speed reporting. Because closing a fiscal year is permanent, we encourage you to pre-close each fiscal 
year as soon as you finish entering and posting all transactions for the year before running the actual closing 
process.
Once you close a fiscal year, information remains available for reporting until it is purged. However, you cannot 
post new activity to a closed year. We recommend you back up your database before closing fiscal years.

Pre-closing or closing a fiscal year

1. From the Administration page in General Ledger, click Close fiscal years. The Close Fiscal Year screen 
appears.
If users are currently logged into the program, a list of those users is displayed. All users must exit the 
program before you can run the pre-closing or closing process. Once all users exit the program, the Close 
Fiscal Year screen appears.

2. In the Action field of the Closing Options frame, select “Print pre-close report”, “Pre-close fiscal year”, or 
“Close fiscal year”.

3. In the Fiscal year field, select the fiscal year to pre-close or close.

Note: We strongly recommend you back up your database before closing fiscal years. Once you close a fiscal 
year, you cannot undo the process; however, creating a backup allows you to restore the database to its state 
before closing the fiscal year.

Warning:  You must define at least one subsequent fiscal year in the program before you can close a fiscal year.

Warning:  Because closing a fiscal year is permanent, we encourage you to pre-close before running the actual 
closing process.
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4. In the Action field of the Report Options frame, select “Preview Report” or “Print Report”. If you select 
“Print Report”, also select a printer. 

5. In the Orientation field, select “Portrait” or “Landscape” depending on how you want the report to 
appear for printing or previewing.

6. Select the Fund filter tab. 
7. In the Include column, select “All” or “Selected”. If you choose “Selected”, the Selected Funds screen 

appears for you to select the funds to close. 
8. Make your selections and click OK. You return to the Filters tab and the filters appear in the Selected 

Filters column.

9. Click Run Now. If you selected “Print pre-close report” on the General tab, the End of Year Report 
generates. If you selected “Pre-close fiscal year” or “Close fiscal year”, a screen appears confirming you 
want to pre-close or close the fiscal year.

10. To continue pre-closing or closing the fiscal year, click Yes.
If the program detects errors during the pre-closing or closing process, you can view the End of Year Error 
Report to see where problems exist. To return to the Close Fiscal Year screen, close the report. This 
report prints automatically without previewing it, if you choose that report option.

If the pre-close or close process is successful, a confirmation message appears. 
11. Click OK to process the End of Year Report, which appears for you to preview or prints depending on the 

report options you select. If you preview the report, you can return to the Close Fiscal Year screen by 
closing the report. If you print the report, the program automatically returns to the Close Fiscal Year 
screen.

Summarizing Fiscal Years

Note: Once a fiscal year is successfully pre-closed or closed, the status for that year will be “Pre-Closed” or 
“Closed” on the Fiscal Years page in Configuration.

Note: All transaction detail for a fiscal year is removed if you summarize the fiscal year. You cannot restore the 
detail without restoring to a previous database.
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To save space in your database, you can use Summarize fiscal years to summarize all transactions for closed fiscal 
years. During the summarizing process, the program removes all transaction detail, including associated 
distributions. The program does, however, save the beginning and ending balances as well as the total net change 
for the project, class, and transaction code distribution for each fiscal period.

Once you summarize a fiscal year, you can produce reports on the beginning and ending balances as well as the 
net change and net asset class for each account. If you have the optional module Projects and Grants, you can 
also produce reports on transaction codes and projects.

Summarizing a closed fiscal year
1. From the Administration page in General Ledger, click Summarize fiscal years. The Summarize Fiscal Year 

screen appears.

2. In the Summarize all fiscal years through field, select the closed fiscal year you want to summarize.

3. To delete batch headers if all transactions within a batch are summarized, mark the checkbox.
4. Click Summarize Now. A confirmation message appears.
5. To continue, click Yes. A processing screen appears. Once the process is complete, a confirmation 

message appears.

6. To return to the Administration page, click OK.

Purging Fiscal Years

By purging a fiscal year, you remove all detail about the fiscal year from your database. However, the program 
does not delete any account numbers and tables used in a fiscal year. You must close a fiscal year before it can be 
purged. Before purging a fiscal year, you should run all financial statements and save or print copies for your 
records. We also strongly recommend you create a backup of your database prior to purging. You cannot recover 
a purged fiscal year without restoring to a backup.

Warning:  You must close the fiscal year before you can summarize it.

Note: If you mark this option and all transactions associated with a batch fall in the fiscal years being deleted, 
the program also deletes the batch header record. We recommend you run a Batch Summary Report before 
deleting batch headers.

Warning:  We strongly recommend running financial statements and creating a backup of your database prior 
to purging.
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Purging a fiscal year

1. From the Administration page in General Ledger, click Purge fiscal years. The Purge Fiscal Year screen 
appears.

2. In the Purge all fiscal years through field, select the closed or summarized fiscal years to purge.
3. Click Purge Now. A confirmation message appears.

4. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a 
confirmation message appears.

5. To return to the Administration page, click OK.

Beginning Balances

In General Ledger, you can enter and lock beginning balances one fund at a time. In addition, because you can 
enter regular and encumbrance amounts for Income Statement accounts, you can also enter beginning balances 
starting with any period. You enter beginning balances only once. You cannot change the beginning balance after 
you lock it.
As long as the balances have not yet been locked, you can also edit existing account beginning balances for each 
fund. After you enter the correct beginning balances for accounts in General Ledger, you can lock beginning 
balances from the Tools menu on the Enter Beginning Balances screen or use the Lock beginning balances link on 
the Administration page. Once you lock the balances, you cannot edit them.

Entering Beginning Balances

After you define accounts, you can enter beginning balances by fund. You can distribute beginning balances by 
class, transaction code, or project. Distributing balances by projects or transaction codes is available only if you 
have the optional module Projects and Grants. You can also enter beginning balances for balance sheet and 
income statement accounts. In addition, you can create accounts “on the fly” as long as you define each segment 
value for the accounts in Configuration.

Note: You cannot see the Purge Fiscal Years link on the Administration page if you do not have security rights 
to purge fiscal years.

Note: To stop purging the selected fiscal year while the processing screen is displayed, you can click Cancel.

Note: You enter beginning balances only once. You cannot change the beginning balance after you lock it.

Note: You can enter regular and encumbrance amounts as beginning balances for Income Statement accounts.
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You can enter beginning balances for only one fiscal year; therefore, we recommend you select the oldest year 
for which you want to generate reports. You can enter beginning balances as of the beginning or middle of a fiscal 
year. To a large extent, the method you use to determine and enter beginning balances determines the reports 
you can generate.
You can run a Trial Balance Report from the Enter Beginning Balances screen for the open fund that lists each 
account balance and shows whether the total amount of debits equals the total amount of credits. You can also 
validate account balances and characteristics prior to locking the balances by selecting validate from the Tools 
menu. For more information about the Trial Balance Report, see the Reports Guide for General Ledger.
If you are unsure of the actual beginning balance, you can enter and lock the beginning balance at zero. You then 
enter beginning balances through manual journal entry. With this method, you can post activity to the general 
ledger before entering the beginning balance. If you lock a beginning balance at zero, reports run for the fiscal 
year in which they were locked show a zero beginning balance.

Entering beginning balances

1. From the Administration page in General Ledger, click Enter beginning balances. The Enter Beginning 
Balances screen appears.

2. In the Fund field, enter the ID of the fund for which you want to enter beginning balances or click the 
binoculars to search for the fund ID.

3. In the Fiscal Year field, select the fiscal year for which you want to enter beginning balances. You can 
enter beginning balances for only one fiscal year.

4. In the Period field, select the fiscal period for which you want to enter beginning balances. 

Warning:  You can enter beginning balances for only one fund at a time.

Note: You can enter beginning balances for only one fiscal period and year per fund.
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5. Click Load Now. The Enter Beginning Balances screen appears. On this screen, a grid displays any 
accounts created for that fund. The account description appears automatically. If you have not yet 
created accounts, the grid is blank.

6. If you have the appropriate security rights, you can create new accounts in the Account Number column. 
The program validates any accounts created “on the fly” when you leave the account cell. The account’s 
description appears in the Description column.

7. In the Type column, specify whether the amount is regular or encumbrance.

8. If the account’s beginning balance is a debit amount, enter the amount in the Debit Amount column. 
Typically, asset accounts have a beginning debit balance.

9. If the account’s beginning balance is a credit amount, enter the amount in the Credit Amount column. 
Typically, liability and fund balance accounts have a beginning credit balance.

10. If you have the optional module Projects and Grants and are closing by project, you must assign project 
distributions to all accounts (or all income statement accounts) if required on the fund. It is very 
important that your fund balance (net assets) account is properly distributed to each project or 
transaction code.

11. To exit and return to the Administration page, click Save and Close.

Note: You can use the utilities on the action bar to edit accounts in the beginning balances grid.

Note:  You can enter only one amount per account in either the Debit Amount or Credit Amount column.

Note: The Project ID and Project Description columns appear on the Enter Beginning Balances screen only if 
you have the optional module Projects and Grants.
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Running a Trial Balance Report
After entering account balances, we recommend you run a Trial Balance Report from the Entering Beginning 
Balances screen to see account balances and if the debits and credits balance. For more information about 
the Trial Balance Report, see the Reports Guide for General Ledger.
1. From the Administration page in General Ledger, click Enter beginning balances. The Enter Beginning 

Balances screen appears.
2. To print the report, from the menu bar, select File, Print, or to preview the report, select File, Print 

Preview. The Select a Parameter File screen appears. 

3. If you have a saved Trial Balance parameter file to use, select the file and click Select. If you do not have a 
saved parameter file, click Add New. The New Trial Balance Report screen appears. 

4. To create the report, make the appropriate selections on the General, Filters and Format tabs. For more 
information about creating a Trial Balance report, see the Reports Guide for General Ledger.
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5. To save the parameter file, from the menu bar, select File, Save. The Save report as screen appears.

6. Give the parameter file a name and description. To give others rights to run or modify this report 
parameter file, mark Others can run this report and Others can modify this report. Click Save to return 
to the report parameter file.

7. To return back to the Select a Parameter File screen, select File, Close. 
8. Select the parameter file and click Select. The report prints or previews

Locking Beginning Balances

By locking beginning balances, you lock the account balance amounts as well as the project, class, and transaction 
code distributions entered on the Enter Beginning Balances screen. You can lock beginning balances for all or 
selected funds.
When you lock beginning balances, General Ledger validates each fund and all closing characteristics to confirm 
that they exist and are in balance. The validation process verifies that a fund’s assets equal the sum of the 
liabilities and net assets. More specifically, the validation process verifies all projects, classes, and transaction 
codes are balanced as required on each fund. Validation also confirms that regular debits equal regular credits 
and all encumbrance debits equal encumbrance credits.

The trial balance for each fund must be in balance before you can successfully lock data. General Ledger will not 
lock balances that create an out-of-balance ledger.
In General Ledger, you can enter transactions into Journal Entry batches before locking balances, but you cannot 
post batches unless all funds are locked for all accounts used in those transactions. You can, however, lock only 
one fund to start entering transactions, but you can post those batches only if all transactions use accounts only 
from that locked fund. If you use accounts from other funds you will receive an error message. 

For all Financial Edge subsidiaries, if at least one fund is locked, you can enter transactions using accounts in that 
fund only. You cannot enter activity for funds that are not locked. You will receive an error message and will not 
be able to save the transaction. 
Once you lock balances, the program posts transactions as of the beginning fiscal period for the selected fund. 
Also, once you lock beginning balances for a fund, you cannot revise or add a beginning balance to any account in 
the fund. 

Warning:  General Ledger disables all posting options until you lock the beginning balances for at least one 
fund.

Note: If you enter and lock the beginning balance at zero and enter the beginning balance through manual 
journal entry, you can post activity to general ledger before entering the beginning balance.

Warning:  For all Financial Edge subsidiaries, if at least one fund is locked, you can enter transactions using 
accounts in that fund only. You cannot enter activity for funds that are not locked. You will receive an error 
message and will not be able to save the transaction. 
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Considerations to Make Before Locking Beginning Balances

Back up database files. This step is crucial. Once you lock beginning balances, you cannot undo the process; 
however, creating a backup allows you to restore the database to its state before beginning balances were 
locked.
Verify that you set up all funds correctly and designated a fund balance account for each fund.
Verify that the beginning balances are entered correctly for each account. You can verify this information by 
printing and reviewing a Trial Balance Report for each fund.
If you use projects on any funds, verify that the correct beginning balances are entered for each project. You 
can print a trial balance for each project.
If you use transaction codes on any funds, verify that the correct beginning balances are entered for each 
transaction code. You can print a trial balance for each transaction code.

Locking beginning balances

1. From the Administration page in General Ledger, click Lock beginning balances. The Lock Beginning 
Balances screen appears on the General tab.
On this tab, you define report options for the Validation Error Report and the Lock Beginning Balances 
Control Report.

2. In the Action field, select to print or preview the reports. If you choose to print the reports, select a 
printer from the corresponding field.

3. In the Orientation field, select “Portrait” or “Landscape”.

Note: A transaction code is an additional field on each transaction that helps you further categorize 
information in reporting and closing fiscal years. You can define up to five transaction code tables. Because it 
can retain equity, a transaction code acts like a project. 

Note: We strongly recommend you make a backup of your database files before you lock beginning balances. 
Once you lock beginning balances, you cannot undo the process. However, you can use a backup to restore 
data to its state prior to locking beginning balances.
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4. Select the Funds tab.

5. In the Lock? column, mark the checkbox next to the fund for which to lock beginning balances. 
6. In the Fiscal Year column, select the year for which to lock beginning balances. Defaults are based on 

information initially entered.
7. In the Fiscal Period column, select the fiscal period for which to lock beginning balances. Defaults are 

based on the fiscal period selected when beginning balances were selected.
8. The Lock As Of column displays the date that the beginning balances will be locked. To change this date, 

select the fund and click Change Dates on the action bar. The Change Dates screen appears.

9. Select a new fiscal year and period. To enter the new lock date and return to the Lock Beginning Balances 
screen, click OK.

10. Once you are ready to lock beginning balances, click Lock Now. A processing screen appears while the 
system validates the fund information. 
If validation is successful, a confirmation message appears. To continue locking beginning balances, click 
Yes.
If validation fails, the Validation Error Report either appears in a preview screen or prints, depending on 
the report options you selected on the General tab of the Lock Beginning Balances screen.
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11. Once locking process is finished, the Lock Beginning Balances screen appears confirming the process is 
complete.

12. To preview or print the Lock Beginning Balances Control Report, click Control Report. To return to the 
Lock Beginning Balances screen, click Close.

Updating Fund Transaction Requirements

On the Update fund transaction requirements screen, you can update transaction history by adding new 
transaction characteristics. You have the ability to add or modify fund transaction requirements, fund closing 
requirements, and transaction history. Updating fund records through this process is necessary only if you have 
locked beginning balances. If beginning balances are not locked, you can update the fund directly. Updates made 
to a fund are recorded on the fund’s History of Changes tab in Configuration.
When you update transaction requirements using the Update Fund transaction requirements link, the program 
updates:
• Posted and unposted transactions for open fiscal years.
• Transactions for closed fiscal years.
• Summarized transactions for closed fiscal years.
• Beginning balances for the earliest fiscal year.

Note: The Control Report lists summary information related to the funds processed. It does not list accounts or 
balances.

Note: Once you overwrite transaction history with new transaction characteristics, you can recover prior 
transaction history only from a backup.
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Updating fund transaction requirements
1. From the Administration page in General Ledger, click Update Fund transaction requirements. The 

Update fund transaction requirements screen appears.

2. In the Update field, select the characteristic to update. This field displays all class, project, and 
transaction code characteristics found on the fund’s Transaction Requirements tab in Configuration. 
These characteristics are table entries defined in Configuration, so the options that display in this field 
depend on what is defined for your organization’s system. Projects and transaction codes appear only if 
you have the optional module Projects and Grants.

3. In the Fund ID field, enter the fund ID or click the binoculars to search for the fund to be updated.
Once you make selections in the Update and Fund ID fields, the current settings for all other fields and 
options appear for that fund. You can change any current setting by making a different selection.

4. In the Require on field, select the accounts to be included in the update: “All Accounts”, “No Accounts”, 
or “Income Statement Accounts”. If the current setting for this field is “Do Not Require”, select “No 
Accounts”.

5. If you select to update “All Accounts” or “Income Statement Accounts” in the Require on field, you must 
select a default value. The default value will be assigned to previous transactions that do not have the 
new requirement.
The selections in the Default value field depend on your selection in the Update field. For example, if you 
select “Class” in the Update field, the Default value field options are “Unrestricted Net Assets”, 
“Temporarily Restricted Net Assets”, or “Permanently Restricted Net Assets”. Default values are required 
only if the characteristic is required to balance. 

6. To require a transaction’s debits and credits to balance by a fund characteristic, mark the Require to 
balance checkbox. This does not mean the characteristic is required on each transaction. Use attributes 
to require the characteristic on each transaction. 

7. To close the fund to a net asset account and distribute information by fund characteristics when closing 
the fiscal year, mark Preserve details during closing. If this checkbox is not marked, information for the 
characteristic is not carried forward when you close the fiscal year. 

8. If you want to apply the default value to existing accounts, mark Apply default value to existing 
accounts. 
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9. To preview the changes, click Preview Change. The Preview Fund Update screen appears.

10. To update the fund requirements, click Change Now. A message screen appears to confirm the update 
information.

11. To confirm the update is correct, click Yes. A confirmation message appears.
12. To complete the update and return to the Administration page, click OK.

Accounts Payable Administration
Tasks that appear on the Administration page only in Accounts Payable include purging vendor activity, purging 
vendors, and merging duplicate vendors.

Purging Vendors and Vendor Activity

By purging vendors you remove all detail about inactive vendors and corresponding vendor activity from your 
database. Vendors with open activity cannot be purged. Active and On hold vendors can be purged if the vendor 
activity for those vendors meet certain requirements. 

Vendor activity that can be purged includes:
• Transactions marked as Posted or Do Not Post.
• Fully resolved transactions: invoices and credit memos must be paid in full; checks cleared or voided; 

recurring invoices fully generated or marked inactive; and purchase orders closed.
• Transactions with transaction dates on or before the cutoff date specified on the General tab. 
• Deleted invoices, credit memos, and purchase orders whose transaction date occurs on or before the cutoff 

date.
Vendor activity that cannot be purged include:

• Transactions linked to other ineligible transactions. For example, the transaction cutoff date is 6/30/02. An 
invoice is dated 6/15/02, but paid with a check dated 7/01/02. Neither transaction can be purged because 
the check’s date does not fall within the specified period. 

Warning:  We recommend creating a backup of your database prior to purging. Once vendor information is 
purged it can be recovered only from a backup.

Note:  Purge vendors is disabled on the Administration page if you do not have security rights to purge 
vendors.
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There are two exceptions to the rules for purging vendors. You cannot purge vendors with 1099 summary 
information or vendors with open-ended recurring invoices (unless marked as inactive). However, you can 
override these rules by marking the exception options on the General tab of the Purge Vendors screen.

Purging vendor activity
1. From the Administration page in Accounts Payable, click Purge vendor activity. The Purge Vendor 

Activity screen appears on the General tab.

2. To exclude vendor activity created after a certain date, enter that date in the Purge vendor activity with 
transaction date before field.

3. To create a query of all vendors excluded because of vendor activity that did not meet purging 
requirements, mark the Create exception query of vendors checkbox.
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4. To print a control report after purging, mark the checkbox and select a printer. The control report 
displays all vendor transactions that were purged.

5. Select the Filters tab. 
6. In the Include column, select to include “All” or “Selected” vendors or vendor attributes. If you choose 

“Selected”, the selected <Filter> screen appears for you to designate specific filters. 
7. Make your selections and click OK. You return to the Filters tab and the filters appear in the Selected 

Filters column.

Warning:  We recommend running a Pre-Purge Report to verify the list of vendors or vendor activity before 
you begin the final purging process.
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8. To verify the vendor activity to be purged, click Pre-Purge Report. The Pre-Purge report lists vendors to 
be purged and those that will not be purged and the reason why.

9. Click Purge Now. A confirmation message appears.
10. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a 

confirmation message appears.
11. To return to the Administration page, click Close.

Purging vendors

1. From the Administration page in Accounts Payable, click Purge vendors. The Purge Vendors screen 
appears on the General tab.

2. In the Purge vendors with these statuses box, mark Active, Inactive, or On hold. Inactive is marked by 
default.

3. In the Purge vendors that were created before field, enter a cut-off date for vendors to be purged.
4. To override the purging rules and allow vendors with 1099 adjustments in the current year or vendors 

with inactive, open-ended recurring invoices to be purged, mark the checkboxes.
5. To create a query of all vendors excluded because they did not meet the purging requirements, mark 

Create exception query of vendors.

Note: All other users should exit the system while you purge. If any transactions you are attempting to purge 
are open by another user, a message appears and the purge process is canceled.
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6. To print a control report displaying all vendors to be purged, mark the checkbox.

7. Select the Filters tab.
8. In the Include column, select “All” or “Selected”. If you choose “Selected”, the selected <Filter> screen 

appears for you to designate specific filters.

9. Make your selections and click OK. You return to the Filters tab and the filters appear in the Selected 
Filters column.

10. To verify the list of vendors to be purged, click Pre-Purge Report.
11. Click Purge Now. A confirmation message appears.
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12. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a 
confirmation message appears.

13. To return to the Administration page, click Close.

Merging Duplicate Vendors

Once you identify duplicate vendor records, you can merge information from a duplicate vendor to a primary 
vendor to create one complete vendor record. Numerous types of information can be merged, including bank 
information, activity, attributes, distributions, and adjustments. For more information about searching for 
duplicate records, see “Searching for Duplicate Records” on page 9.

Merging duplicate vendors
Select to merge information from a duplicate vendor with information from a primary vendor. 

1. From the Administration page in Accounts Payable, click Merge Vendors. The Merge Vendors screen 
appears.

2. In the Duplicate vendor field, enter the vendor’s name or use the binoculars to search for the name.
The duplicate vendor is the vendor whose record information is merged into the primary vendor’s 
information. The duplicate vendor is deleted after the merging process.

3. In the Primary vendor field, enter the vendor’s name or use the binoculars to search for the name.
The primary vendor is the receiving vendor who will receive the merged information and whose record 
will not be deleted.

4. To merge the vendor records, click Merge Now. A confirmation message appears. Click Yes to continue 
merging or No to return to the Merge Vendors screen.

Note:  You can click Cancel to stop purging vendor activity while the processing screen is displayed. 

Note:  You can merge vendors regardless of Active, Inactive, or On Hold status.

Note:  Biographical information is merged into the primary record only if the record does not already contain 
the data. Also, you can merge data into a blank field, but you cannot merge a blank into a field containing data.

Note: If your Financial Edge program is integrated with The Raiser’s Edge, be aware that if the deleted vendor 
is linked to a constituent record in The Raiser’s Edge, the link will be broken.
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5. If you select Yes, after the merge is complete, a message appears asking if you want to merge another 
pair of vendors. Click Yes and the screen resets to create another merge. Click No and the screen closes 
and returns to the Administration page.

Accounts Receivable Administration
A task that appears on the Administration page only in Accounts Receivable is merging duplicate clients.
In Accounts Receivable, you can also generate fixed amount automatic payments. 

Merging Duplicate Clients

Once you identify duplicate client records, you can merge information from a duplicate client to a primary client 
to create one complete client record. You can merge individual client records only with another individual client 
record, and organization records only with another organization record. Numerous types of information can be 
merged, including addresses, activity, attributes, and annotations. For more information about searching for 
duplicate records, see “Searching for Duplicate Records” on page 9.

Merging duplicate clients
Select to merge information from a duplicate client with information from a primary client. 

1. From the Administration page in Accounts Receivable, click Merge Clients. The Merge Clients screen 
appears.

2. In the Duplicate client field, enter the client’s name or use the binoculars to search for the name.
The duplicate client is the client whose record information is merged into the primary client’s 
information. The duplicate client is deleted after the merging process.

3. In the Primary client field, enter the client’s name or use the binoculars to search for the name.
The primary client is the receiving client who will receive the merged information and whose record will 
not be deleted.

Note:  You can merge clients regardless of client status.

Note:  Biographical information is merged into the primary record only if the record does not already contain 
the data. Also, you can merge data into a blank field, but you cannot merge a blank into a field containing data.
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4. To merge the client records, click Merge Now. A confirmation message appears. Click Yes to continue 
merging or No to return to the Merge Clients screen.

5. If you select Yes, after the merge is complete, a message appears asking if you want to merge another 
pair of clients. Click Yes and the screen resets to create another merge. Click No and the screen closes 
and returns to the Administration page.

Generating Fixed Amount Automatic Payments

Fixed automatic payments are set up on a regular schedule for a pre-determined amount. By generating fixed 
amount automatic payments, you create fixed amount payments for selected client records. For each client 
selected in the payment run, Accounts Receivable automatically creates one deposit record for the process and a 
payment record for each of the fixed amount scheduled payments.

Generating fixed amount automatic payments
1. From the Administration page in Accounts Receivable, click Generate fixed amount automatic 

payments. The Generate Fixed Amount Automatic Payments screen appears.

2. To include payments for specific dates in fixed schedules, mark For fixed schedules, include payments 
with these dates. In the Dates field, select a date or a date range.

3. To include payments with unlimited schedules, mark For unlimited schedules, include payments that 
meet this criteria. In the field under the checkbox, select “Generate payments through” and enter a date 
or select “Generate specific number of payments” and enter a number.

4. In the filters grid, you can filter the records included in the processing. For more information about 
filtering criteria, see the Program Basics Guide.

5. To create an output query of the payment records included, mark Create output query of payment 
records checkbox.
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6. Select the Deposit tab to enter information for the deposit record created in this process.

7. In the Deposit date field, enter a transaction date for the deposit.
8. In the Entry date field, enter an entry date for the deposit.
9. In the Status field, select “Open” or “Closed.”

10. In the Description field, enter a description of the deposit.
11. In the Post status field, select “Not yet posted” or “Do not post”.
12. In the Post date field, enter a posting date for the deposit.
13. In the Bank account field, select a Accounts Receivable bank account.

The GL cash account field displays the cash account assigned to the selected Accounts Receivable bank 
account.

14. In the Projected Deposit Totals frame, enter numbers in the Projected # of payments and Projected 
total fields. You can use these numbers as accuracy checks before posting.
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15. Select the Payment tab to enter information for the payment records created in this process.

16. In the Payment date field, select “Use scheduled date” or select “Use specific date” and enter the date. 
The Post status and Post date fields display the post information for the payment.

17. In the Source field, select a payment source.
18. In the Comment field, enter a comment. 
19. Click Preview to view payment records. The Payments to Generate screen appears.

20. In the Generate column, unmark the checkboxes for any payments you do not want to generate.
21. When you are ready to generate payments, click Generate Now.
22. A confirmation message appears when the process is complete. Click OK to return to the Administration 

page.
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Fixed Assets Administration
Tasks that appear on the Administration page only in Fixed Assets include purging assets, switching to a 
mid-quarter convention, and creating an asset inventory.

Purging Assets

Using Purge Assets in Fixed Assets, you can remove any asset that has been fully depreciated or disposed. All 
transactions for the asset must be marked as Do not post or Posted. You can view a pre-purge report to verify the 
list of assets to be purged. A control report automatically prints after purging that lists all assets removed during 
the process. You cannot recover purged assets without restoring to a backup.

Purging fixed assets

1. From the Administration page in Fixed Assets, click Purge Assets. The Purge Assets screen appears on the 
General tab.

2. To create a query of all assets excluded because they did not meet the purging requirements, mark 
Create exception query of assets.

3. To print a control report displaying all assets to be purged, mark Print a control report on and select a 
printer.

Note: We strongly recommend creating a backup before purging assets. You cannot recover purged assets 
without restoring to a backup.
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4. Select the Filters tab. 

5. In the Include column, select “All” or “Selected”. If you choose “Selected”, the selected <Filter> screen 
appears for you to designate specific filters. 

6. Make your selections and click OK. You return to the Filters tab and the filters appear in the Selected 
Filters column.

7. To verify the list of assets to be purged, click Pre-Purge Report.
8. Click Purge Now. A confirmation message appears.
9. To continue the purging process, click Yes. A processing screen appears. Once purging is complete, a 

confirmation message appears.
10. To return to the Administration page, click Close.

Switch to Mid-Quarter Convention

Switching to mid-quarter convention in Fixed Assets involves two functions: determining whether mid-quarter 
convention applies to the selected year and switching all applicable assets put into service in the selected year to 
a mid-quarter convention. Only assets put into service in the selected year that use MACRS with a half-year 
convention will be switched. 
You must use the mid-quarter convention if during the year the total bases of depreciable property placed in 
service during the last quarter of the year exceeds 40 percent of the total bases of all depreciable property placed 
in service during the year. Once assets are switched to the mid-quarter convention, the program zeros out all 
year-to-date period depreciation for new assets that use the half-year convention and recalculates depreciation 
using a mid-quarter convention.

Note: You can run a Mid-Quarter Convention Test Report in Reports in Fixed Assets to determine which assets 
you can switch.
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Switching to mid-quarter convention
1. From the Administration page in Fixed Assets, click Switch to Mid-Quarter Convention. The Switch to 

Mid-Quarter Convention screen appears.

2. In the Year field, select the year to switch to or test for mid-quarter convention.

3. To run the mid-quarter test before switching, mark Confirm that IRS requirements are met before 
switching. If you do not mark this option, the program automatically switches to mid-quarter without 
testing.

4. To create an output query of all assets switched to mid-quarter convention, mark the checkbox.
5. To begin the test or switch, click Switch to mid-quarter convention.
6. If you marked Confirm that IRS requirements are met before switching, a screen appears stating 

whether the selected year meets or fails the mid-quarter test.

7. Click Switch. A message appears confirming the number of assets switched to mid-quarter.
8. To return to the Administration page, click Close.

Asset Inventory

You can use the Asset Inventory to identify assets that have been moved or are missing by comparing asset 
records in Fixed Assets to an inventory file. Inventory files contain asset numbers or asset IDs and locations or 
departments for assets that have been inventoried either by scanning or manual counts. The scanning process 
produces an electronic file, while manual inventory counts must be converted to an electronic file outside of 
The Financial Edge. Using Asset Inventory, you can identify which locations or departments have been 
inventoried and automatically update asset locations or departments. 

Asset Inventory Reports
You also create preview and print inventory control reports. The control report includes a variety of inventory 
comparisons. All of these report sections are included by default:

Note: To test for mid-quarter without switching, mark Confirm that IRS requirements are met before 
switching.

Note: If you are only testing, click Cancel.

Note: In Mail, you can create barcode labels to scan when conducting asset inventories. For more information 
see the Mail Guide.
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• Assets inventoried, location matches control group — Lists asset records in the inventory file and control group 
with matching asset numbers and the same locations/departments.

• Assets inventoried, location does not match control group location — Lists asset records in the inventory file 
and control group with matching asset numbers but different locations/departments.

• Assets inventoried, not one of the control group assets — Lists asset records in the inventory file which have no 
records in the control group with matching asset numbers. Location/department is not considered and only 
valid asset numbers are included. Records in this group with invalid asset numbers are included in the 
exception report.

• Assets in the control group, not inventoried — Lists asset records in the control group which have no records in 
the inventory file with matching asset numbers.

Creating an asset inventory

1. From the Administration page in Fixed Assets, click Asset Inventory. The Asset Inventory screen appears. 

Note: Mark Only show my asset inventories to display only assets inventories you created.
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2. Click New Inventory. The New Asset Inventory screen appears on the General tab.

3. In the Inventory Name and Description fields, enter a name and description for the inventory.
4. In the Date Completed field, enter the date the inventory was completed.
5. In the Inventory file name field, enter the file path of the scanned inventory or click the ellipses to 

browse to the file’s location.
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6. Select the File Layout tab. This tab is similar to the File Layout tab in Import records; however, you can 
use only delimited files.

7. In the Field Separators and Text Qualifiers frame, select the field separators and text qualifiers used in 
the import file. For example, in the Field Separator field, a comma may separate fields in a *.csv file. In 
the Text qualifier field, select a character, such as a quotation mark, to set off text that is imported into 
one field in the database. 

If you select “Other” in the Field separator field or “Custom” in the Text qualifier field, enter the 
information in the corresponding text box.

8. In the Inventory File Field Names frame, specify whether your inventory file contains field names on the 
first line of the file or if the file does not contain field names. 

9. The Inventory File Field column of the grid displays fields from the inventory file. You cannot edit this 
column.

Note: You must map the Location/Department and the Asset Number/Asset ID/Serial Number fields on the 
File Layout tab before you can process the file or create a pre-process report. 

Note: Enter the actual separator, not the separator name. For example, enter “.”, not “period”.

Note: Assets records must have a location or department assigned. 
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10. In the Asset Record Field column of the grid, select the asset record fields to compare to the inventory 
file fields.

11. Select the Filters tab. 
On the Filters tab you can select filters to designate the group of assets included in the inventory. If you 
do not select any filters, the control group of assets will contain all asset records except for disposed 
assets.
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12. To include disposed assets in the control group, mark Include disposed assets. 

13. Select the Attributes tab. On this tab, you can add, update, or delete attributes using a variety of qualities 
or characteristics created in Configuration. Attributes may include information relating an asset to a 
particular cost center, expense category, department, or program. For more information about adding 
attributes, see the Program Basics Guide.

Note: An attribute is a reporting tool you use to group information based on a common theme. With attributes 
defined, you can filter information to your specifications. 
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14. Select the Notes tab. On this tab you can add notes about the asset inventory, such as participants, 
conditions, special circumstances, or actions taken. For more information about adding notes, see the 
Program Basics Guide.

15. Select the Format tab. 
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16. In the Include these inventory comparisons box, you can select to include four report sections with 
various inventory comparisons. All report sections are included by default. Unmark the checkbox for any 
report section you do not want in the report. For more information about the report sections, see “Asset 
Inventory Reports” on page 46.

17. Mark Subtotal by <location/department> to sort and subtotal each of the four report sections by the 
control group location or department column. 

18. To create an output query of assets in the control group not inventoried, mark the checkbox.
19. Before processing the file, you can click Pre-Process Report to review the changes to occur. When you 

are ready to process the file, close the report to return to the New Asset Inventory screen.
20. Click Process File. If you selected to create an output query of assets, the Create Static Query screen 

appears.
21. Enter a name in the Query Name field and click Save. The program begins processing.
22. When processing is complete, the Asset Inventory File Processed screen appears displaying the number 

of records processed and the number of exceptions. 
Records will not process successfully if:
• Asset numbers are not valid.
• Inventory file records do not contain a numeric field entry for the asset number.
• Inventory file records do not contain an alphanumeric field entry for location or department.
• The inventory file contains duplicate asset numbers. If duplicates exist, the first will process and all 

others will be reported as exceptions.
23. From this screen, click View Control Report or Close. 

Note: The name for this checkbox depends on whether the inventory file contains departments or locations.

Note: You must have security rights to edit assets and add locations to update locations. To update 
departments, you must have security rights to edit assets.
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24. If there are assets in the inventory with locations that do not match the system location, a message 
appears asking if you want to update the locations. Click Yes to update. The Update Locations screen 
appears listing all asset locations to update.

25. Click Update to continue. The Assets Updated screen appears listing the number of assets processed and 
the number of exceptions. Click View Control Report to identify any exceptions or click Close to return to 
the New Asset Inventory screen.

Student Billing Administration
Tasks that appear on the Administration page only in Student Billing include merging records, promoting 
students, managing billing groups, generating fixed amount automatic payments, automatically generated 
transactions, importing from a tuition management service, and creating financial aid schedules.

Status Wizards

The Status Wizards provide an efficient way for global or individual processing of applicant or student 
progression. To provide consistency, you can create and save multiple sets of parameters customized for your 
school.
If you have Admissions Office installed, you can access the Update Applications and Mark for Reenrollment 
wizards.

Updating Applications

With the Update Applications wizard, you can update the status information of applications. For example, you 
can accept or deny applicants.
If you have Admissions Office and Student Billing installed, you can use the Update Applications wizard to enroll 
applicants as students.

You can access the Updating Applications wizard from Administration, or from the applicant record.

Updating applications
1. From the Status Wizards page in Administration, select Update Applications and click New. The Update 

Applications Wizard appears. 
2. In the From school field, select the school associated with the applications you want to update.
3. In the Status field, you can select an updated status for the application records.
4. In the Status date field, you can enter a date for the new status. In the Status reason field, you can enter 

a reason for the new status.
5. To update the Current grade field on the applicant record, mark Set current grade. You can update the 

current grade based on a promotion schedule or enter the grade value.
If you choose “Based on promotion schedule”, select a promotion schedule in the Promotion schedule 
field. Enter a value in the Current grade if blank field if you want to update blank Current grade fields on 
the applications included in the process.
If you choose “To value”, select a value in the Current grade field. To overwrite the existing value, mark 
the Overwrite existing current grade checkbox.

Note: Security rights for the Status Wizards are set in Administration. 

Note: With the Update Applications wizard, you can update and process multiple records at one time. We 
recommend creating a valid backup before running the wizard.
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6. To create a query of the applicant records that processed unsuccessfully and have an active application, 
mark Create exception query.

7. To create a query of the applicant records that are updated when you run the wizard, mark Create query 
of applicants with changes.

8. To print a report of the applicant records that are updated, mark Print a control report on and select a 
printer.

9. Click Next. The Additional Information tab appears. 
10. In the Year apply field, select the academic year for which the applicant(s) is applying.

11. In the Term apply field, select the term for which the applicant(s) is applying.
12. In the Recruiter field, enter the applicant’s recruiter. You can click the binoculars to access a list of 

faculty/staff records.
13. In the Application date field, enter the date of the application.
14. In the Date accepted field, enter the date the application was accepted. 

15. In the Date enrolled from field, enter the date the applicant will be enrolled in the school. 
16. In the Class of field, enter the expected graduation year.
17. In the Board type field, select the type of boarding the student will need.
18. If you have only Admissions Office and Student Billing installed (no Registrar’s Office), the Enroll 

applicants as students checkbox appears. 
Mark this option to convert applicant records to student records.

19. Click Next. The Checklist/Action tab appears.

Note: Records that receive warnings are not included the exception query. A warning indicates the record 
processed successfully but may not have been fully updated.

Note:  The fields on the Additional Information tab are optional.

Note:  If you select “Today” in the date fields and save the parameters to run this wizard again, you do not 
have to update these fields each time you run the saved wizard.
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20. In the Delete frame, you can mark Tracks or Checklist items to delete specified tracks and checklist items 
associated with the application. 

21. In the Add frame, you can mark Action or Tracks and checklist items to add specified actions, tracks, and 
checklist items to the application.
To add action information, click Action Information. To add tracks and checklist items, click Checklist 
Item Information. For more information about adding actions, tracks, and checklist items, see the 
Records Guide for Admissions Office.

22. Click Next. The Filters tab appears. 
23. In the filters grid, you can filter the applicant information you want to process. For example, you can 

process one applicant or a group of applicants. For more information about filtering, see the Program 
Basics Guide.

24. To view a list of records included in the update, click Preview Included Records.
25. Click Preprocessing Report if you want to preview a report of changes to records before running the 

wizard.

26. Click Run Now to run the Update Applications wizard. The Save Update Applications Wizard as screen 
appears.

27. In the Name field, enter a name for your grouping of records. In the Description field, you can enter a 
description that will help you or other users identify the grouping later.

28. To allow other users to run or change the wizard with the parameters you have set up, mark Others can 
run or Others can modify.

29. Click Save to save your parameters. A confirmation message appears. Click Yes to run the wizard.
30. When the wizard is complete, a control report appears. Once you have reviewed the report, click the red 

X to return to the Update Application wizard.
31. Click Save and Close to return to the Status Wizards page.

Marking Students for Reenrollment

With the Mark for Reenrollment wizard, you can reenroll existing students and generate student progression 
entries to prepare them for the next year. Reenrollment includes students being promoted to a new school 
within the school system, but does not include students who are graduating out of the school system.
When you run the Mark for Reenrollment wizard, an applicant and application are enabled for students who have 
never been an applicant or have no application.
You can access the Mark for Reenrollment wizard from Administration or from the student record.

Security rights for the Status Wizards are set in Administration. 

Tip: To provide consistency to your application process, you can create and save multiple sets of parameters. 
For example, you might create a set of parameters to accept applicants and one to deny applicants.

Note:  Graduating students refers to students graduating out of the school system, not a student graduating 
from one school to another within the school system.

Note: With the Mark for Reenrollment wizard, you can update and process multiple records at one time. We 
recommend creating a valid backup before running the wizard.
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Marking students for reenrollment
Reenrollment includes students being promoted to a new school, but does not include students who are 
graduating out of the school system.
1. From the Status Wizards page in Administration, select Mark for Reenrollment and click New. The Mark 

for Reenrollment Wizard appears.

2. In the From school field, select the school from which you are reenrolling the students. This field appears 
only if you have more than one active school.

3. In the Status field, you can select a status for student records you are reenrolling. 
4. In the Status date field, you can enter the current date of the status. 
5. In the Status reason field, you can enter a reason for the current status.
6. In the To year field, select the year to which you are reenrolling the students. You can select “This 

academic year” or “Next academic year.”
7. To create a query of the student records that processed unsuccessfully, mark Create exception query.

Records that receive warnings are not included the exception query. A warning indicates that the record 
processed successfully but might have something that did not get updated, such as the student 
progression entry or the prefix.

8. To create a query of the student records that are updated when you run the wizard, mark Create query 
of students with changes.

9. To print a report of the student records that are updated, mark Print a control report on [ ] and select a 
printer.
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10. Click Next. The Additional Information tab appears.

11. In the Date enrolled from field, enter the date the student will be reenrolled in the school.
If you select “Today” in the Date enrolled from field and save the parameters to run this wizard again, 
you do not have to update this field each time you run the saved wizard.

12. In the Grade enrolled field, select the grade level for which the student is being reenrolled.
13. In the Class of field, enter the expected graduation year.
14. In the Board type field, select the type of boarding the student will need.

Note:  If you select “Today” in the Date enrolled from field and save the parameters to run this wizard again, 
you do not have to update this field each time you run the saved wizard.
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15. Click Next. The Checklist tab appears.

16. In the Delete frame, you can mark Tracks or Checklist items to delete specified tracks and checklist items 
associated with the applicant record(s).

17. In the Add frame, you can mark Tracks and checklist items to add specified tracks and checklist items to 
the student/applicant record(s).

To add track and checklist items to the applicant, click Checklist Item Information. For more information 
about adding tracks and checklist items, see the Records Guide for Admissions Office.

18. Click Next. The Attributes tab appears.

Note:  When you run the Mark for Reenrollment wizard, an applicant and application is enabled for students 
who have never been an applicant or have no application.



60 CH A PT E R  
19. In the first grid, you can select attributes to copy from the student side of the record to the applicant side 
of the record. For a student attribute to copy to the applicant side of the record in Admissions Office, the 
attribute must also be defined as an applicant attribute in Configuration in Admissions Office.
• In the Attribute Type column, select the attribute to add or update on the applicant side of the record.
• In the Overwrite Existing? column, mark the checkbox to overwrite the existing value for the attribute 

if the applicant side of the record already exists and contains the attribute.
If the attribute is defined as unique (can be used only once on a record) and you do not mark 
Overwrite Existing?, the attribute is not copied and generates an exception. If the attribute already 
exists on the applicant side of the record, but is not defined as unique and you mark Overwrite 
Existing?, a new instance of the attribute is copied but the original is not overwritten.

20. In the Please provide values for the Admissions Office applicant required attributes, you enter values 
for required applicant attributes. You can also add additional attributes to applicant records by selecting 
attributes in the Attribute Type column.
• In the Description column, select or enter a description of the attribute. 
• In the Date column, enter a date to record when you add the attribute.
• If this attribute type is required on an applicant record, the program automatically marks the checkbox 

in the Required column.You cannot edit this column.
• In the Comments column, enter any additional comments or more detailed information about the 

attribute. You can enter free-form text in this column.
If you are copying a required attribute from the student side of the record to the applicant side, the 
copied value is used instead. 
If a required value is already on the applicant side of the record, and the attribute is defined as unique, 
the attribute is not copied and generates an exception. If the attribute is not defined as unique, a new 
instance of the attribute is copied but the original is not overwritten.

21. Click Next. The Filters tab appears. 
22. In the filters grid, you can filter the student information you want to process. For example, you can 

reenroll one student or a group of students. For more information about filtering, see the Program Basics 
Guide.

23. To view a list of records included in the update, on the action bar click Preview Included Records.
24. Click Preprocessing Report if you want to preview a report of changes to records before running the 

wizard.

25. Click Run Now to run the Mark for Reenrollment wizard. The Save Mark for Reenrollment Wizard as 
screen appears.

26. In the Name field, enter a name for your grouping of records. In the Description field, enter a description 
that will help you or other users identify the grouping later.

Tip:  To provide consistency, you can create and save multiple sets of parameters to use when you run a 
wizard.
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27. To allow other users to run or change the wizard with the parameters you have set up, mark Others can 
run or Others can modify.

28. Click Save to save your parameters. A confirmation message appears. Click Yes to run the wizard.
29. When the wizard is complete, a control report appears. Once you have reviewed the report, click the red 

X to return to the Mark for Reenrollment wizard.
30. Click Save and Close to return to the Status Wizards page.

Adding, Copying, and Deleting Bill Codes

Using the Add, Copy, or Delete bill codes link in Administration, you can quickly add new bill codes or copy or 
delete existing ones for a selected group of records. 
If you generated transactions based on bill codes on records, we recommend that you do not delete these from 
student records so you have a record for historical information and troubleshooting purposes.

Globally add bill codes
1. In the Action field, select “Add Bill Codes” to globally add bill codes to a group of records.
2. In the Query name field, browse to the query containing the records you want to add bill codes to.
3. In the Bill Code field, select the bill code to add. 
4. In the Billing Cycle field, define the start and end dates of the bill codes you are adding. Select a billing 

cycle or “<Specific Dates>” to define a date range in the From and To fields. 
5. To print a control report of the bill codes added, mark Print control report. 
6. To create a query of records the program cannot add the bill codes to, mark Create an exception query. 
7. To review the changes before processing, click Preprocessing report. This report also lists any exceptions.
8. Click Add Now. The process run and then a completion screen appears listing the number of bill codes 

processed, added, and the exceptions. 
9. Click Close to return to the Administration page.

Globally copy bill codes
1. In the Action field, select “Copy Bill Codes” to globally copy bill codes from a group of records.
2. In the Query name field, browse to the query containing the records you want to copy bill codes from.
3. Bill codes that fall within the specified date range are copied. In the Copy bill codes from field, select 

“<Specific date>” to enter a date in the Ending on field. The program copies bill codes that end on the 
date entered. The starting date for the bill code copied to the record is the first date after the date 
entered in the Ending on field. The copied bill code ends in the same increment of days as the one being 
copied from. For example, if start date for the bill code being copied from is 8/1/08 and the ending date is 
8/1/09, the starting date for the bill code copied to the record is 8/2/09 and the ending date is 8/2/10.
If you use billing cycles, select a billing cycle to copy from in the Copy bill codes from field and select the 
billing cycle you want to copy the bill code to in the to field. 

4. Select the bill codes to copy by moving bill code descriptions in the left box to the right using the arrow 
buttons. 

5. To print a control report of the bill codes copied, mark Print control report. 
6. To create a query of records the program cannot copy the bill codes from, mark Create an exception 

query. 
7. To review the changes before processing, click Preprocessing report. This report also lists any exceptions.
8. Click Copy Now. The process run and then a completion screen appears listing the number of bill codes 

processed, copied, and the exceptions. 
9. Click Close to return to the Administration page.
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Globally delete bill codes
1. In the Action field, select “Delete Bill Codes” to globally delete bill codes from a group of records.
2. In the Query name field, browse to the query containing the records you want to delete bill codes from.
3. In the For field, select a billing cycle, “<All Dates>, or “<Specific dates>” option. If you select “<Specific 

Dates>”, you can define a date range in the From and To fields. Bill codes that fall into the specified 
period of time will be deleted. 

4. Select the type of bill codes to delete by moving bill code descriptions in the left box to the right using the 
arrow buttons. 

5. To print a control report of the bill codes deleted, mark Print control report. 
6. To create a query of records the program cannot delete bill codes from, mark Create an exception query. 
7. To review the changes before processing, click Preprocessing report. This report also lists any exceptions.
8. Click Delete Now. The process run and then a completion screen appears listing the number of bill codes 

processed, deleted, and the exceptions. 
9. Click Close to return to the Administration page.

Merge Process

The merge process moves information from the duplicate faculty/staff, individual, organization, applicant, and 
student records, to the primary records.

If you integrated Admissions Office and Registrar’s Office with Student Billing, you can merge the records 
converted from Student Billing with records in . This utility merges records that match based on the duplicate 
criteria you define, such as last name, first name, and address. The result is a single record that contains a 
combination of information from both records. 

Merge Considerations
Before running the merge utility, you should review the following information and recommendations:

• Each time you run the merge utility, we recommend you make a valid backup of the database. Large 
amounts of data are being manipulated during this process, and without a backup, correcting the data could 
be difficult. You can recover merged records only by restoring to a backup.

• The amount of time it takes to run the merge utility will vary depending on your hardware and how many 
records you are merging. 

• If you are trying to merge a large number of records, you should run the merge utility multiple times using 
different duplicate criteria. 

• To ensure that applicant and student relation information merges successfully, we recommend you merge 
applicant and student records before merging individual and faculty/staff records. 

• We recommend you merge duplicate records instead of deleting one of them so you do not lose any 
information.

• If you have saved merge parameter files, we recommend you review and validate the accuracy of your 
parameter files before merging. You should save any parameter files you create for future reference.

• If you previously used Academy Manager to integrate these programs in version 6 before converting to 
version 7, we recommend you first run the merge utility using Academy ID as the criteria. Then run again 
using name and address as the criteria.

•  and Student Billing security is set up separately, even for shared records. However, delete functionality is 
allowed only if a user has access to delete in both programs.

• You can merge multiple records at one time, however, we recommend running merge in groups.

Note: As a precaution, we recommend running a backup each time you merge records.
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• If you want to merge a student and individual, or applicant and individual, the individual will need to be 
converted first.

• When merging faculty and individual records, if the individual record has attributes which are not set up in 
Configuration for faculty records, the attributes for the individual record will be deleted during the merge 
process. To ensure these attributes are not deleted, the same attributes must exist on the faculty record 
prior to merging.

• When you integrate Admissions Office and Registrar’s Office with Student Billing, all the new student 
records will have an active billing status if you selected “Active” for the When an applicant is enrolled or a 
new student is created in , default billing status to [ ] business rule in Student Billing. This is why the Keep 
billing status from the duplicate record option on the merge parameter form is very important.

• If records created by the Student Billing conversion need to be designated primary because the data is more 
up to date, you need to consider that the Current status created for those records for Registrar’s Office are 
just a default and do not reflect the appropriate current status. This is why the Keep current status from the 
duplicate record option on the merge parameter form is very important.

• Not merging duplicate records can be a form of data corruption. For example, in an integrated system, you 
might have two records per student in your database. Changes that users make to one record, such as phone 
number and address updates, will not be reflected on the other record. Therefore, Registrar’s Office users 
and Student Billing users will not view the same information when accessing a record. 

Merging Records
The merge utility is available from the Administration page of Admissions Office, Registrar’s Office and Student 
Billing as a tool for ongoing duplicate identification and merging. 
Before merging records, we recommend you review the Integration Planning Checklist located in the Integrating 
Student Billing with  guide, as well as “Merge Considerations” on page 62.

Merging records
1. From the Administration page, click Merge Records.
2. To create a new merge, click New on the action bar. The Merge Records screen appears.

3. In the Merge using field, select “specified criteria” or “specific records”. If you select “specified criteria”, 
you can enter duplicate criteria and review duplicate records based on that criteria before merging them 
into primary records. We recommend you select this option.
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If you select “specific records”, you manually select the primary records and the duplicate records to 
merge into the primary records on the Preview tab.

4. In the Merge records within these record types box, mark the record types you want to merge. For 
example, to search only for duplicate student records, only mark the Students checkbox. 
If you are merging students and want to include applicants in the duplicate checking, mark Include 
students when checking for duplicates.

5. If you selected “specified criteria” in the Merge using field, you must select duplicate criteria in the grid 
for each selected record type. In the Field Name column, select the fields to use in the duplicate search. 
In the Length column, enter the number of characters to check in each field during the duplicate search.
When selecting duplicate criteria, please keep the following issues in mind:
• When including “Academy ID” as criteria, Academy IDs that are zero or blank are ignored.
• If you converted a record with an ID or SSN matching one already in the database, the duplicate ID or 

SSN was stored as an attribute instead. So if you are including ID or SSN as criteria, the program also 
checks for attributes with these values.
You must have the appropriate security rights to merge records based on Social Security numbers. For 
more information, see the Security chapter of the Administration Guide for The Financial Edge.

• On certain record types, you can also mark an additional checkbox to check for duplicates in other 
record types. In applicant criteria, you can select to include student records. In faculty/staff criteria, 
you can select to include individual records. In student criteria, you can select to include applicant 
records.

• Make sure you are choosing fields that were used the same across offices.
6. In the When resolving a conflict between the records being merged use field, select which record to use 

when merging records containing different values.
• If you select “date last changed”, the program considers the record with the latest date last changed 

value as the primary record. We recommend you do not select this option if merging after conversion. 
If you are merging records after converting, be aware that the date last changed for the records is the 
conversion date.

• If you select “the record with the attribute added by the Student Billing conversion”, the program 
considers the record converted from Student Billing 6 to Student Billing 7 as the primary record. If no 
records have this attribute or multiple records have this attribute, the program uses the one with the 
latest date last changed value as the primary record. Select this option if you want the student record 
coming from Student Billing as the primary record. 

• If you select “the record without the attribute added by the Student Billing conversion”, the program 
considers the record not converted from Student Billing 6 to Student Billing 7 as the primary record (if 
there are two records, one with the attribute and one without). Select this option if you do not want 
the student record coming from Student Billing to be the primary record. 

7. Mark Keep billing status from the duplicate record if you want to overwrite the billing status on the 
primary record with the billing status from the duplicate record. This is especially important when first 
merging Student Billing 7 and Admissions Office/Registrar’s Office 7 records together when Student 
Billing 7 records are selected as the duplicate record.

8. Mark Keep current status from the duplicate record if you want to overwrite the current status on the 
primary record with the current status from the duplicate record. This is especially important when first 
merging Student Billing 7 and Admissions Office/Registrar’s Office 7 records together when Admissions 
Office/Registrar’s Office 7 records are selected as the duplicate record.

Note:  A faculty/staff record type in Student Billing is an individual record with Faculty/Staff marked on the Bio 
1 tab.

Note:  We recommend using the merge utility as a tool for ongoing duplicate record identification and 
merging.



A D M I N I ST RA T I O N 65
9. To create an output query of merged records included in the processing, mark Create an output query of 
merged records.

10. Select the Filters tab to further filter the included records. This tab is only available if you choose to 
merge using specified criteria. 

11. Set the filters you want for the records included in the merge. 
12. Select the Addresses tab to establish criteria for how to compare addresses on the records you are 

merging. 

When comparing address lines, the program ignores punctuation and uses address abbreviation 
equivalents to search for addresses that are the same but may be punctuated or abbreviated differently. 
For details, see “Comparing Addresses” on page 68.

13. In the When merging addresses, check the following fields for identical values box, mark checkboxes for 
the address fields to check for duplicates. This helps the program determine which addresses on the 
duplicate record already exist on the primary record.
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If you want the addresses to merge even if the address type is different and everything else is identical, 
unmark Address type.

14. If you selected to check address lines, in Use [ ] characters of the address lines, enter the number of 
characters to check in the address lines for duplicates.

15. If you selected to check the ZIP/postcode, in the Use [ ] characters of the ZIP/postcode, enter the 
number of characters to check in the ZIP/postcode for duplicates.

16. Select the Preview tab to view the records the program considers duplicates based on your criteria. 

17. The records listed are considered the primary records. To expand all of the rows for the records, click 
Expand All on the action bar. The rows under a primary record are considered the duplicate records that 
will be merged with the primary record.

18. Review the duplicate records found to determine if they look like duplicates or if you need to adjust your 
criteria. For example, if many duplicate records appear for one primary record, you probably need to 
adjust your criteria.
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• To help with reviewing duplicate records, you can include columns for your criteria in the grid. 
Right-click the grid and select Columns to control the columns that appear.

• To review a record, select the row and click Open on the action bar.
• If there is more than one duplicate record for a primary record, the order of the duplicate records 

under the primary record determines which duplicate record’s data is used first if a field is blank on the 
primary record. Put the most accurate duplicate record first in order. You can use the Up and Down 
buttons to rearrange the rows.

19. If you do not want to merge a record, unmark the checkbox in the Merge? column for the record.
20. If you selected “specific records” in the Merge using field on the General tab, select the Preview tab to 

select the primary records along with the duplicate records to merge.

21. To enter a primary record, click Load Primary Record on the action bar to search for and select a record.
22. To enter a duplicate record to merge into a primary record, search for and select the record in a row 

below the primary record. To add a row, you can select the row of the primary record and click Insert 
Duplicate on the action bar.
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If there is more than one duplicate record for a primary record, the order of the duplicate records under 
the primary record determines which duplicate record’s data is used first if a field is blank on the primary 
record. Put the most accurate duplicate record first in order. You can use the Up and Down buttons to 
rearrange the rows.

23. To omit a record from the merge, unmark the checkbox in the Merge? column.
24. When you are ready to begin the merge, click Merge.
25. When the merge is complete, the Merge Records Complete screen appears, displaying statistics about 

the processing.

26. Click Close. The control report appears with more detail about the processing.

Comparing Addresses
When comparing addresses, the program ignores punctuation and uses address abbreviation equivalents to 
search for addresses that are the same but may be punctuated or abbreviated differently.

Punctuation

The following punctuation is ignored in the address text fields when searching for duplicate addresses:

Hyphen Colon Apostrophe
Period Semicolon Parenthesis
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This punctuation is also ignored in phone types with a phone number type of Telephone Number, Fax Number, or 
Other, but not in phone types with a phone number type of Email Address or Web Address/URL.

Address Abbreviation Equivalents

This table lists the address abbreviation equivalents the program uses when comparing address lines.

Carriage 
return/line 
feed

Address Equivalent Address Equivalent Address Equivalent

Annex Anx Freeway Fwy Rest Rst

Apartmen
t

Apt Gardens Gdns Ridge Rdg

Arcade Arc Gatewa
y

Gtwy River Riv

Avenue Ave Glen Gln Road Rd

Bayou Byu Green Grn Shoal Shl

Beach Bch Grove Grv Shoals Shls

Bend Bnd Harbor Hbr Shore Shr

Bluff Blf Haven Hvn Shores Shrs

Bottom Btm Heights Hts Spring Spg

Boulevar
d

Blvd Highway Hwy Springs Spgs

Branch Br Hill Hl Square Sq

Bridge Brg Hills Hls Station Sta

Brook Brk Hollow Holw Stravenu
e

Stra

Burg Bg Inlet Inlt Stream Strm

Bypass Byp Island Is Street St

Camp Cp Islands Iss Summit Smt

Canyon Cyn Isle Isle Terrace Ter

Cape Cpe Junction Jct Trace Trce

Causeway Cswy Key Ky Track Trk

Center Ctr Knolls Knls Trail Trl

Circle Cir Lake Lk Trailer Trlr
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Cliffs Clfs Lakes Lks Tunnel Tunl

Club Clb Landing Lndg Turnpike Tpke

Corner Cor Lane Ln Union Un

Corners Cors Light Lgt Valley Vly

Course Crse Loaf Lf Viaduct Via

Court Ct Locks Lcks View Vw

Courts Cts Lodge Ldg Village Vlg

Cove Cv Manor Mnr Ville Vi

Creek Crk Meado
ws

Mdws Vista Vis

Crescent Cres Mill Ml Wells Wls

Crossing Xing Mills Mls West W

Dale Dl Mission Msn East E

Dam Dm Mount Mt North N

Divide Dv Mountai
n

Mtn South S

Drive Dr Neck Nck Northea
st

NE

Estates Est Orchard Orch Northwe
st

NW

Expressw
ay

Expy Pkwy Pky Southea
st

SE

Extension Ext Parkway Pky Southwe
st

SW

Falls Fls Pines Pnes First 1 or 1st

Ferry Fry Place Pl Second 2 or 2nd

Field Fld Plain Pln Third 3 or 3rd

Fields Flds Plains Plns Fourth 4 or 4th

Flats Flt Plaza Plz Fifth 5 or 5th

Ford Frd Point Pt Sixth 6 or 6th

Forest Frst Port Prt Seventh 7 or 7th

Forge Frg Prairie Pr Eighth 8 or 8th

Address Equivalent Address Equivalent Address Equivalent
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How Information on Duplicate Records Merges with the Primary Record
This table provides information about how data on duplicate records merges with data on the primary record.

Fork Frk Radial Radl Ninth 9 or 9th

Forks Frks Ranch Rnch Tenth 10 or 10th

Fort Ft Rapids Rpds

Information Record Type What happens?

Bio 1 All person records Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Bio 2  / Birth 
Information

Applicant/Student - all 
views

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Bio 2  / Billing 
Information and 
Billing Defaults

Student in Student Billing Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Bio 2  / In-state 
Resident and 
Recruiting 
Information

Applicant in Admissions 
Office

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Bio 2  / Other 
Schools Applied To

Applicant in Admissions 
Office

Entries on duplicates are 
added to primary (though 
only one can have the 
Attending checkbox 
marked).

Bio 2  / Dormitory, 
Phone number, 
Roommate, Room, 
and Transportation

Student in Registrar’s 
Office

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Bio 2  /  Cars Student in Registrar’s 
Office

Entries on duplicates are 
added to primary.

Bio 2 / Date hired, 
Terminated on, 
Reason

Faculty/Staff Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Address Equivalent Address Equivalent Address Equivalent
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Bio 2 / 
Department/Positi
on, Education, 
Certifications

Faculty/Staff Any entries on duplicate 
but not on primary are 
added.

Visa/Passport Applicant/Student - 
Admissions Office and 
Registrar’s Office views, 
Faculty/Staff

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Demographics Applicant/Student - all 
views, Faculty/Staff, 
Individuals

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Photo Applicant/Student - all 
views
Faculty/Staff, Individuals

Copies information if on 
duplicate but not on 
primary, but does not 
replace existing data.

Primary address All records A record must have a 
primary address. If 
primary record does not 
have a primary address, 
the primary address from 
a duplicate record will be 
added. 

If an address matches on 
the duplicate and primary 
records, but there are 
contacts on the duplicate 
record that are not on the 
primary record, the 
contacts are added to the 
address on the primary 
record. However, if a 
contact type is already in 
use on the primary 
record, the contact 
number for that contact 
type will only be copied 
from the duplicate if the 
contact number on the 
primary is blank.

Information Record Type What happens?
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Additional 
addresses

All records Any entries on duplicate 
but not on primary are 
added.

If an address matches on 
the duplicate and primary 
records, but the address 
on the duplicate record is 
linked to records not 
linked to on primary 
record, the links are 
added to the address on 
the primary record.

If an address matches on 
the duplicate and primary 
records, but there are 
contacts on the duplicate 
record that are not on the 
primary record, the 
contacts are added to the 
address on the primary 
record. However, if a 
contact type is already in 
use on the primary 
record, the contact 
number for that contact 
type will only be copied 
from the duplicate if the 
contact number on the 
primary is blank.

Primary addressee 
and Primary 
salutation

All person records If primary record does not 
have a primary addressee 
or salutation, the primary 
addressee or salutation 
from a duplicate record 
will be added.

Additional 
addresses and 
salutations

All person records Any entries on duplicate 
but not on primary are 
added.

Information Record Type What happens?
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Attributes All records Entries on duplicates are 
added to primary.

If a unique attribute exists 
on the primary record, 
attributes from the same 
category on the duplicate 
record cannot be added.

For applicant/students, 
merging is specific to each 
view: applicant view in 
Admissions Office, 
student view in 
Registrar’s Office, and 
student view in Student 
Billing.

Notes All records Entries on duplicates are 
added to primary.

For applicant/students, 
merging is specific to each 
view: applicant view in 
Admissions Office, 
student view in 
Registrar’s Office, and 
student view in Student 
Billing.

Actions All records Entries on duplicates are 
added to primary.

For applicant/students, 
merging is specific to each 
view: applicant view in 
Admissions Office, 
student view in 
Registrar’s Office, and 
student view in Student 
Billing.

Media All person records Entries on duplicates are 
added to primary.

For applicant/students, 
merging is specific to each 
view: applicant view in 
Admissions Office, 
student view in 
Registrar’s Office, and 
student view in Student 
Billing.

Information Record Type What happens?
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Financial Aid Applicant/Student - all 
views

Any entries on duplicate 
but not on primary are 
added.

If the same academic year 
exists on both, 
information from the 
duplicate is added if it 
does not exist on the 
primary.

History of Changes All records An entry is generated only 
when information is 
added to key fields on the 
primary record.

Relationships All records Any entries on duplicate 
but not on primary are 
added.

If the same relationship 
exists on both, 
information from the 
duplicate is added if it 
does not exist on the 
primary.

Activities Student in Student Billing Entries on duplicates are 
added to primary.

Annotations Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Exceptions on 
Payers 

Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Statements Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Bill Codes Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

EFT Bank 
Information

Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Default Schedules Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Automatic 
Payments

Student in Student Billing Entries on duplicates are 
added to primary.

Information Record Type What happens?
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Student 
Progression

Student in Student Billing Any entries on duplicate 
but not on primary are 
added.

Education Applicant/Student in 
Admissions Office and 
Registrar’s Office

Any entries on duplicate 
but not on primary are 
added.

Tests Applicant/Student in 
Admissions Office and 
Registrar’s Office

Any entries on duplicate 
but not on primary are 
added.

Medical Applicant/Student in 
Admissions Office and 
Registrar’s Office

Any entries on duplicate 
but not on primary are 
added.

Activities Applicant/Student in 
Admissions Office and 
Registrar’s Office

Any entries on duplicate 
but not on primary are 
added.

Conduct Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Applications Applicant in Admissions 
Office

Any entries on duplicate 
but not on primary are 
added.

If an entry matches on the 
duplicate and primary 
based on Year Apply, 
information from the 
duplicate entry is added if 
it does not exist on the 
primary entry.

An applicant view can be 
created for a primary 
record if the School and 
Current Status of an 
application on the 
duplicate matches an 
enrollment on the 
primary.

Information Record Type What happens?
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Enrollments Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

If an entry matches on the 
duplicate and primary 
based on School and 
Grade Enrolled, 
information from the 
duplicate entry is added if 
it does not exist on the 
primary entry.

A student view can be 
created for a primary 
record if the School and 
Current Status of an 
enrollment on the 
duplicate matches an 
application on the 
primary.

Schedule Changes Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
NOT added.
Changes can be recorded 
when enrollments are 
added to a primary record 
during merge.
If a class is added to the 
primary record and a 
change is recorded, 
Changed On and Changed 
By will display the date of 
the merge and the user 
who ran the merge. You 
may want to note the 
original date and user 
who added the class on 
the duplicate record in 
the Comments column of 
the Schedule Changes 
screen.

Status Log Applicant/Student in 
Admissions Office and 
Registrar’s Office

Any entries on duplicate 
but not on primary are 
added (only when 
application or enrollment 
is added).

Course Requests Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Information Record Type What happens?
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Promoting Students

If you do not have Registrar’s Office, you promote students through Administration in Student Billing. By 
promoting students, you advance selected students to a new grade and you can also process graduating 
students.

Schedule Student and Faculty/Staff 
in Registrar’s Office

Any entries on duplicate 
but not on primary are 
added.

Grades Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Attendance Student in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Checklist Items Applicant in Admissions 
Office

Any entries on duplicate 
but not on primary are 
added.

Conduct Faculty/Staff in Registrar’s 
Office

Entries on duplicates are 
added to primary.

Courses Faculty/Staff in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Restrictions Faculty/Staff in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Faculty/staff 
information for 
Faculty Access for 
the Web

Faculty/Staff in Registrar’s 
Office

Any entries on duplicate 
but not on primary are 
added.

Integration links 
with Raiser’s Edge 
records

All records mapped for 
integration

The link of the primary 
record is maintained, 
along with the address 
and relationship links.

However, if a primary 
record does not have a 
link, but a duplicate 
record does, the link from 
the duplicate is copied to 
the primary.

Information Record Type What happens?
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Promoting students
1. From the Administration page in Student Billing, click Promote students. The Promote Students screen 

appears.

2. In the Billing status field, select a billing status to use for returning students.
3. To update the records of students who have graduated, mark Upgrade graduating students. In the fields 

below, select a billing status, enrollment status, graduation date, date enrolled to date, and reason left 
for the graduating students. To update the Grade left field to the grade of the student before graduating, 
mark Update grade left.

4. To create a query of students not included in the processing, mark Create exception query of students.
5. To create a query of students included in the processing, mark Create output query of students.
6. To print a control report, mark Print control report on and select a printer.
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7. Select the Filters tab.

8. You can filter the records included in the processing. For more information about filtering criteria, see the 
Program Basics Guide.

9. Select the Attributes tab. 

Note:  Bill codes selected must apply to the current date to be included. 
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10. In the Action column, you can select to add, update, or delete attributes for students when you promote 
them.

11. In the Attribute Type column, select an attribute type.
12. In the Description column, enter or select a description for the attribute type.

If you selected a table type attribute that uses short descriptions, you select the attribute description in 
the Short Description column. The Description column completes automatically.

13. In the Date column, enter the date you add the attribute or another date relevant to the attribute.
14. If the attribute is required, the checkbox is marked in the Required column.
15. In the Comments column, enter any additional information about the attribute.
16. Select the Preview tab.

17. Unmark the checkbox in the Promote? column for any students you do not want to promote. 
18. To review the changes before processing, click Preprocessing Report.
19. Once you have reviewed the preprocessing report and are ready to promote the students, click Process 

Now.
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20. When processing is complete, the Promote Students Complete screen appears, displaying statistics about 
the processing.

21. Click Close. The control report appears with more detail about the processing.

Managing Billing Groups

With billing groups, you can quickly add or update student, individual, or organization records. You can also use 
this feature to create links and relationships among associated records. For example, you can add records for an 
entire family at one time. You can link these records and copy address and billing information from one record to 
all the others.
You can also manage billing groups from the Students, Individuals, or Organizations page in Records. For more 
information about records, see the Records Guide for Student Billing.

Adding a record using Manage Billing Groups
1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups 

screen appears.

2. From the dropdown, you can select Add New Student, Add New Individual, or Add New Organization. 
For this procedure, we will add a new individual. The procedure is similar for students and organizations.

Note:  Click Duplicate Record Search to verify that a record does not already exist before creating a new 
record.
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3. After clicking Add New Individual, “New Individual” appears in the Records box on the left and you can 
enter biographical information in the fields that appear on the right. 

4. Select the Defaults tab.
5. Click Billing Defaults to add billing defaults. 

Note:  If you limit users’ security rights to add records, we recommend that you also limit the rights to Manage 
Billing Groups. A user with rights to Manage Billing Groups can add any type of record. 
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6. Click Relationships to add relationships. 

7. Select the Addresses tab. On this tab, you can add address and contact information for the individual. 

8. When you finish making changes, you can:
• Click Finish and New to save and close the individual record and open a new billing group 

automatically.
• Click Finish and Close to save and close the individual record and return to the Administration page.

Note:  When you click Finish and New or Finish and Close, a completion screen appears listing the number of 
new records created and the number updated.
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Updating an existing record using Manage Billing Groups
You can add or update a single record using Manage Billing Groups. Though this procedure is for individual 
records, the procedure is similar for student and organization records.
1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups 

screen appears.

2. In the Record Name field, enter the individual name or click the binoculars to locate the individual record 
to update. 

3. Click the down arrow next to Load all associated records and select “Load only selected record”. 
Biographical information for the individual appears.

4. You can add or make changes to biographical information.
5. Select the Defaults tab.

Note:  When you add or update a record using Manage Billing Groups, changes are not saved until you click 
Finish and New or Finish and Close.
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6. Click Billing Defaults to view or edit billing defaults. 

7. Click Relationships to view or edit relationships. 
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8. Select the Addresses tab. On this tab, you can view, edit, or add new addresses for the individual. 

9. When you finish making changes, you can:
• Click Finish and New to save and close the individual record and open a new billing group 

automatically.
• Click Finish and Close to save and close the individual record and return to the Administration page.

Viewing a billing group
Though this procedure is for individual records, the procedure is similar for student and organization records.
1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups 

screen appears.
2. In the Record Name field, enter the individual name or click the binoculars to locate the individual 

record. 

Note:  When you click Finish and New or Finish and Close, a completion screen appears listing the number of 
new records created and the number updated.
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3. To view an individual’s associated records, click the down arrow next to Load all associated records and 
select one of these options:
• Load all associated records — Loads any record that is a relation, payer, or statement recipient for the 

selected individual.
• Load all related records — Loads all records who are relations for the selected individual.
• Load all payers — Loads all records who are payers for the selected individual.
• Load all statement recipients — Loads all records who are statement recipients for the selected 

individual.
4. The individual and any associated records that meet the selected criteria appear in the Records box on 

the left. When you select a record in the list, biographical information for that record appears on the 
right. You can edit information on the Records, Defaults, or Addresses tabs for each record. 

5. When finished viewing: 
• Click Finish and New to save and close the individual record and open a new billing group 

automatically.
• Click Finish and Close to save and close the individual record and return to the Administration page.

Adding records to a billing group
Scenario: Tom Boatwright is a new  at your school. His wife, Marion, has taught there for several years. An 
individual record already exists for Marion so you create a new billing group to quickly add an individual 
record for Tom. You create a relationship between the records and copy Marion’s address to Tom’s record.
1. From the Administration page in Student Billing, click Manage billing groups. The Manage Billing Groups 

screen appears.
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2. In the Record Name field, enter “Marion Boatwright” and click Load all associated records. Marion’s 
record appears on the screen.

3. To add Tom to the billing group, click the down arrow next to Add New Student and select “Add New 
Individual”.

4. On the Records tab, enter biographical information for Tom. 

5. Select the Defaults tab.

6. Click Relationships. 
7. In the Name column, select “Marion Boatwright”. 

Note:  If you limit users’ security rights to add records, we recommend that you also limit the rights to Manage 
Billing Groups. A user with rights to Manage Billing Groups can add any type of record. 
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8. In the Relationship column, select “Wife” and in the Reciprocal Relationship column, select “Husband”. 
Mark the checkbox in the Spouse column. 

9. Select the Addresses tab. 
10. Click Copy Address From. Use the Open screen to select Marion’s record. The Addresses for Marion 

Boatwright screen appears. 

11. Mark the checkbox for the address to copy and click Copy Now. The address appears on Tom’s record. 

Note: When you add or update a record using Manage Billing Groups, changes are not saved until you click 
Finish and New or Finish and Close.

Note: When you click Finish and New or Finish and Close, a completion screen appears listing the number of 
new records created and the number updated.
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12. To save the records and exit:
• Click Finish and New to save and close the records and open a new billing group automatically.
• Click Finish and Close to save and close the records and return to the Administration page.

Generating Fixed Amount Automatic Payments

Fixed automatic payments are set up on a regular schedule for a pre-determined amount. By generating fixed 
amount automatic payments, you create fixed amount payments for student, individual, or organization records. 
For each record you select using filters, Student Billing automatically creates one deposit record for the process 
and a payment record for each of the fixed amount scheduled payments.

Generating fixed amount automatic payments
1. From the Administration page in Student Billing, click Generate fixed amount automatic payments. The 

Generate Fixed Amount Automatic Payments screen appears.

2. To include payments for specific dates in fixed schedules, mark For fixed schedules, include payments 
with these dates. In the Dates field, select a date or a date range.

3. To include payments with unlimited schedules, mark For unlimited schedules, include payments that 
meet this criteria. In the field under the checkbox, select “Generate payments through” and enter a date 
or select “Generate specific number of payments” and enter a number.

4. In the filters grid, you can filter the records included in the processing. For more information about 
filtering criteria, see the Program Basics Guide.

5. To create an output query of the payment records included, mark Create output query of payment 
records checkbox.
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6. Select the Deposit tab to enter information for the deposit record created in this process.

7. In the Deposit date field, enter a transaction date for the deposit.
8. In the Entry date field, enter an entry date for the deposit.
9. In the Status field, select “Open” or “Closed.”

10. In the Description field, enter a description of the deposit.
11. In the Post status field, select “Not yet posted” or “Do not post”.
12. In the Post date field, enter a posting date for the deposit.
13. In the Bank account field, select a Student Billing bank account.

The GL cash account field displays the cash account assigned to the selected Student Billing bank 
account.

14. In the Projected Deposit Totals frame, enter numbers in the Projected # of payments and Projected 
total fields. You can use these numbers as accuracy checks before posting.
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15. Select the Payment tab to enter information for the payment records created in this process.

16. In the Payment date field, select “Use scheduled date” or select “Use specific date” and enter the date. 
The Post status and Post date fields display the post information for the payment.

17. In the Source field, select a payment source.
18. In the Comment field, enter a comment. 
19. Click Preview to view payment records. The Payments to Generate screen appears.

20. In the Generate column, unmark the checkboxes for any payments you do not want to generate.
21. When you are ready to generate payments, click Generate Now.
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22. A confirmation message appears when the process is complete. Click OK to return to the Administration 
page.

Generating Transactions Automatically

Using Generate Transactions Automatically, you can automatically generate billing schedules and scheduled 
charges and credits. You can also generate Tuition Refund Plan (TRP) charges and determination table and 
reversal schedule transactions. To generate TRP charges, the program checks for TRP items on the records you 
are including and calculates the new TRP charge amount based on the percentage of the TRP item out of the 
amount of all the transactions included in the TRP calculation.
On the Generate Transactions Automatically page, you can select a saved parameter set or click New to add a 
new parameter set for transactions.
To help you filter the parameter sets, you can select a calculation type in the Generate field.

Generating transactions automatically
1. From the Administration page in Student Billing, click Generate transactions automatically. The 

Generate Transactions Automatically page appears.
2. Click New. The Generate Transactions Automatically screen appears.

3. In the Generate field, select how to generate transactions.
• To both create billing schedules from bill codes and generate charges and credits, select “Automatic 

Billing Schedules and Scheduled Charges/Credits”. This includes advance deposits and financial aid. 
This will not generate TRP schedules, but will generate TRP charges from existing schedules.

• To create only billing schedules from bill codes, select “Automatic Billing Schedules Only”. This will not 
generate TRP schedules.

• To generate charges/credits for existing schedules only, select “Scheduled Charges/Credits Only”. This 
includes advance deposits, financial aid, and TRP.

• To create TRP billing schedules and charges, select “TRP Schedules and Charges”. This calculates TRP 
charges based on billing schedules that would be created using bill codes. To exclude billing schedules 
that are not created yet, select “None” in the Bill Codes row on the Filters tab.
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• To generate student invoice line items, credits, and adjustments based on settings from the 
determination table, data from student and course records, and entries in reversal schedules, select 
“Determination Table and Reversal Schedule Transactions”. 

4. If you are generating charges and credits, in the For this range field, select the date range or billing cycle 
to use.

5. If you are creating billing schedules, in the Billing schedule transaction date field, enter the date to 
determine which bill codes are used to create schedules and the transaction date for created schedules.

6. If you are creating billing schedules, in the For automatic items without a bill code, generate billing 
schedules for field, select “No Records” or “All Records”.

7. If you selected “TRP Schedules and Charges” in the Generate field, select the date range to use in the 
Base TRP charges on this range field.

8. In the Add this comment to each transaction field, you can enter a comment to add to each generated 
transaction.

9. To generate grade-based fees based on the student’s next grade using the promotion schedule, mark For 
grade-based billing, use student’s next grade.
If you also have Registrar’s Office, instead of this checkbox you have the For grade-based billing, use 
student’s grade as of field, where you can enter a date as of which to generate the fees. The program 
refers to the student’s progression entry as of that date to determine the student’s grade.

10. If you selected “Determination Table and Reversal Schedule Transactions” in the Generate field:
a. Select an academic year and session in the Academic year and Session fields. 
b. You can mark Recalculate all included records to recalculate existing invoice line items, credits, and 

adjustments. For example, you deleted credits for students and need to recalculate the credits the 
students should receive for withdrawing or dropping out of a class.

c. In the Generate transactions for frame, mark what transaction types to automatically generate: 
Course fees, Residence fees, and Meal plan fees.

d. In the Transaction date field, select the transaction date to record on the invoices, credits, and 
adjustments generated.

e. If invoices do not number automatically (a setting in Student Billing business rules), enter an invoice 
number in the Number invoices sequentially starting with [ ] field.

11. To include payers whose records are on hold, mark Include payers on credit hold.
If “Never” is selected for Allow new charges when account is On Hold in student, individual, or 
organization business rules, this checkbox does not apply to that record type. For more information 
about business rules, see the Configuration Guide for Student Billing.

12. To create a query of records not included in the processing, mark Create an exception query.
13. To print a control report, mark Print control report on and select a printer to print a control report on.

Note: To see the Generate transactions for frame, you must have the optional module Residence Life. If you do 
not, you can only generate transactions for course fees.
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14. Select the Filters tab.

15. You can filter the records included in the processing. For more information about filtering criteria, see the 
Program Basics Guide.

16. Select the Transaction Defaults tab.

17. In the Due date field, select how to determine the due date for the charges generated.

Note:  If you selected “Determination Table and Reversal Schedule Transactions” in the Generate field, fewer 
filters appear on the Filters tab. 
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• If you select “Based on transaction date”, you can select to use a specific number of days from the 
transaction date, a specific day of the current or next month, or the same transaction date of the next 
month.

• If you select “Specific date”, a field appears for you to enter the date. If you use a specific date, be 
aware that this date will be used for all transactions included in the process.

18. In the Post date field, select how to determine the post date to use.
• If you select “Based on transaction date”, you can select to use the transaction date, a specific number 

of days from the transaction date, a specific day of the current or next month, or the same transaction 
date of the next month.

• If you select “Specific date”, a field appears for you to enter the date. If you use a specific date, be 
aware that this date will be used for all transactions included in the process.

• If you select “Last date of GL Fiscal Period”, the last date of the current fiscal period is used.
19. In the Post Status field, select the post status to use on the transactions, either “Not Yet Posted” or “Do 

Not Post”.
20. To review the transactions that will be generated before actually generating them, click Pre-Generation 

Report.
21. When you are ready to generate the transactions, click Generate Now.
22. A confirmation message appears when the process is complete. Click OK to return to the Administration 

page.

Globally Delete Transactions

When you use Globally Delete Transactions, you can undo transactions without restoring to a backup. You can 
only delete transactions that are not posted or have a post status of Not yet posted or Do not post. Use the global 
delete if you need to delete individual transactions as if they never existed. When you delete the transactions, 
they are permanently erased from the database. Globally delete transactions is different from archive and purge 
where a record of the purge is recorded in the general ledger. The only record of the transaction deleted is if you 
choose to save the parameter file and control report. The parameter file contains the parameters used to delete 
and the control report contains a basic log of the transactions deleted. We strongly recommend, however, that 
you create a backup of your database before you delete transactions. Once you delete the transactions, you can 
only restore them if you have a backup of your database.
You can choose to delete financial aid and generated credits, credits, charges, invoices, advance deposits and 
generated credits, payments, or billing schedules.

Globally delete transactions
1. From the Administration page in Student Billing, click Globally Delete Transactions. The Globally delete 

transactions page appears.

Note: Using a specific due date is useful if you generate transactions once a month, all with the same due date.
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2. Click New. The Globally Delete Transactions screen appears.

3. In the Delete field, select which type of transactions to delete.
4. In For this range field, select which date range you want to delete transactions. Only the type of 

transactions you chose in the Delete field for the date range you choose will delete.
5. To create a query of records not included in the processing, select Create an exception query.
6. To print a control report, select Print control report on and select a printer on which to print the report.
7. Select the Filters tab.
8. You can filter the records included in the processing. For more information about filtering criteria, see the 

Program Basics Guide.
9. To review the transactions that will be deleted before you delete them, click Preview Changes.

10. When you are ready to delete the transactions, click Delete Now. A confirmation screen appears.
11. To delete, click Yes.
12. A confirmation message appears when the process is complete. Click OK to return to the Administration 

page.

Import from Tuition Management Service

You can import tuition transactions directly into Student Billing records. You select the tuition management 
service, select the import file, and specify the bank account to use. The import file format is a fixed length, 
222-character text string. 
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Importing transactions from a tuition management service
1. From the Administration page of Student Billing, click Import from tuition management service. The 

Import Tuition Management Service Transactions screen appears.

2. In the Tuition management service field, select the service you use.
3. In the Import file field, click the browse button to search for and select the file to import.
4. In the Match records by using field, select whether to use a student ID or individual ID to match imported 

records with existing records. The ID type you select becomes a required field.
5. In the Bank account for deposit field, select a bank account.
6. In the Default application restriction field, select an application restriction or “<No Restriction>”. If you 

select an application restriction, it is assigned to the deposit created for this import and the deposit’s 
associated payments. 

7. To print a control report, mark Print a control report on and select a printer.
8. To create a query of records included in the processing, mark Create output query of records.
9. To start the import, click Import Now.

10. A confirmation message appears when the process is complete. Click OK to return to the Administration 
page.

Import Fields
These are the fields available for import.
Record ID. Either Student ID, Individual ID, Student SSN, or Contract Number is required.
Transaction Type. This is required. A transaction type can be payment (PY), credit (CR), charge (CH), refund 

(RF), advanced deposit (AD), financial aid (FA), or fee schedule (FS).
Fee Number. This is required for credits, charges, refunds, advanced deposits, financial aid, and billing 

schedules. This becomes the billing item category and item in Student Billing. You cannot use the billing item 
categories of product or per usage when importing.
Fees imported through a tuition management service must have a 3-character ID. The ID can be 
alphanumeric.

Date of Transaction. This is required. This is used to identify the correct billing item.
Amount of Transaction. This is required. You cannot enter zero amounts for charges or refunds.
Description. This is not required. This appears as a comment in Student Billing.
Paid By. This is not required. This becomes a note in Student Billing.
Source Code. This is not required. This becomes a note in Student Billing.
Posting Date. This is used for charges, credits, and refunds with a post status of Not posted.
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Post Status. This is used for charges, credits, and refunds. Values can be N for Not posted, P for Posted, or D for 
Do not post. The program resets P to D upon import to not affect the general ledger.

Due Date. This is used for charges and advance deposits.

GL Account Number. You can enter 7 characters here or set up the GL Account Numbers on the billing items 
in Student Billing.

Pay Type. This is required for payments and advance deposits. Values can be 1 for Cash, 2 for Check, and 3 for 
Other.

Check Number. For Cash or Other pay types, the program checks for check number first, then checks for 
reference number. This is used for payments and advance deposits.

Check/Reference Date. This is used for payments and advance deposits.
Amount Bills. For cash pay types, this must match the cash amount in bills. This is used for payments and 

advance deposits.
Amount Coins. For cash pay types, this must match the cash amount in coins. This is used for payments and 

advance deposits.
Other Pay. This becomes a note in Student Billing. This is used for payments and advance deposits.
Reference Number. For Cash or Other pay types, the program checks for check number first, then checks for 

reference number. This is used for payments and advance deposits.
Parent/Guardian #. This is the ID of an individual in Student Billing who is the payer. If a value is not entered, 

but there is one payer on the student record in Student Billing, that payer is used. If there are multiple payers 
on the student record, you receive an error and you must designate the payer to use in the import file. If 
there are no payers on the student record, it is assumed that the student record is its own payer.

Contract Number. Either Student ID, Student SSN, or Contract Number is required. This is used to identify the 
relationship between a payer and a student, and to apply the payment to the correct student. 

Student SSN. Either Student ID, Student SSN, or Contract Number is required.
Carriage Return/Line Feed. This is optional.

Creating Financial Aid Schedules

You can create financial aid schedules for students based on their financial aid application information. To create 
financial aid schedules, the program looks at amounts of financial aid that are granted based on your filters. 
This process does not generate individual transactions. For information about generating transactions 
automatically, see “Generating Transactions Automatically” on page 94.

Note: We recommend that billing items already have GL distributions set up.
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Creating financial aid schedules
1. From the Administration page of Student Billing, click Create financial aid schedules. The Create 

Financial Aid Schedules screen appears.

2. In the Transaction date field, enter the date of the transaction.
3. In the Qualification date field, select the date of the items to include based on the date in the Date 

qualified field on the financial aid application.
4. In the Grant date field, select the date of the items to include based on the date in the Date granted field 

on the financial aid application.
5. To include only financial aid with the Accepted checkbox marked on the financial aid application, mark 

Include only accepted financial aid qualifications.
6. To combine all financial aid items with the same billing item, mark Combine financial aid with the same 

billing item.
7. To create a query of students not included in the processing, mark Create exception query of students.
8. To create a query of students included in the processing, mark Create output query of students.
9. To print a control report, mark Print a control report on and select a printer.
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10. Select the Financial Aid Types tab.

11. In the Type column, select a type of financial aid.
12. In the Billing Item column, select a billing item to associate with each financial aid type. You can select to 

use the same billing item for multiple types of financial aid. The date range is also included in the billing 
item name so you can easily search for the applicable item.

13. The billing item’s description appears in the Description column.
14. Select the Filters tab.

15. You can filter the records included in the processing. For more information about filtering criteria, see the 
Program Basics Guide.
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16. Select the Attributes tab.

17. In the Action column, you can select to add an attribute.
18. In the Attribute Type column, select an attribute type.
19. In the Description column, enter or select a description for the attribute type.

If you selected a table type attribute that uses short descriptions, you select the attribute description in 
the Short Description column. The Description column completes automatically.

20. In the Date column, enter the date you add the attribute or another date relevant to the attribute.
21. If the attribute is required, the checkbox is marked in the Required column.
22. In the Comments column, enter any additional information about the attribute.
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23. Select the Preview tab.

24. Unmark the checkbox in the Include? column for any students and billing item combinations you do not 
want to include.

25. To review a report of what will be processed before actually creating the financial aid schedules, click 
Preprocessing Report.

26. When you ready to create the financial aid schedules, click Process Now.
27. When the process is complete, a completion screen appears.

28. To open the control report, click View Control Report.
29. To close the screen and return to the Administration page, click Close.

Globally Add Hold Codes

From Student Billing or, if you have Registrar’s Office, click the Globally Add Hold Codes link on the 
Administration page to add hold codes to a group of student records.
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Globally add hold codes
While this procedure explains how to globally add hold codes in Student Billing, you can use the same steps 
in Registrar’s Office.
1. From the Administration page of Student Billing, click Globally Add Hold Codes. The Globally Add Hold 

Codes screen appears.

2. In the Query name field, click the binoculars to locate a query of student records you want to add hold 
codes. If you have not created a query of the records, you can click Add a New Query on the Open Query 
screen.

3. In the Hold code field, select the hold code to add to the student records. 
4. In the Start date field, enter a start date for the hold code.
5. In the End date field, enter an end date for the hold code, if one exists.
6. In the Reason field, you can edit the reason for the hold code or use the default reason you entered in 

Configuration.
7. To print a report of the student records assigned a new hold code, mark Print control report.
8. To create a query containing the students who were not assigned the hold code, mark Create exception 

query.
9. To review a preprocessing report before globally adding the hold code, click Preprocessing Report. The 

report lists the successfully added hold codes, student records with exceptions, and a description of the 
exceptions.

10. When you are ready to begin the global add, click Add Now. When the add is complete, a confirmation 
screen appears.

11. To view the control report, click View Control Report.

Note: You define hold codes in Configuration. For more information about how to define hold codes, see the 
Configuration Guide for Student Billing.
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12. Click Close. You return to Administration page.

End Hold Codes

From Student Billing or, if you have Registrar’s Office, click the End Hold Codes link on the Administration page 
to end hold codes for a group of student records.

End hold codes
While this procedure explains how to globally end hold codes in Student Billing, you can use the same steps 
in Registrar’s Office.
1. From the Administration page of Student Billing, click End Hold Codes. The End Hold Codes screen

appears. All records for students with hold codes appear.

2. In the End? column, select the student records to end the hold code.
3. To filter the records by hold code type, select a hold code type in the Hold code field.
4. To view more information about a student record, in the grid select the student and click Go to student.

The student record appears.
5. You can also click Deselect all or Select all to quickly edit the end hold codes.
6. To end the hold codes, click Update. All student records with the End? column selected no longer have

active hold codes on the student record. You return to the Administration page.
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You can change information in your database for a specified group of records. Using a global change, you can add, 
replace, partially replace, delete, increase/decrease, copy, swap, or move information, depending on which field 
you select to change. You can save a global change to run again as originally created or with modifications.

After globally changing information, you can view a control report detailing all the records in your database that 
were changed or not changed, and why. Also, you can create a query of records that were changed and an 
exception query of records that cannot be changed. You can use these queries in other areas of the program.
In security settings, the supervisor can restrict the rights that allow users to globally change records. If a user does 
not have rights, the Globally change records link does not appear on the Administration page. Furthermore, 
users must have rights to globally change Social Security, credit card, and bank account numbers. For more 
information, see the Security chapter of the Administration Guide for The Financial Edge.

Global Change Tabs
For a specific record type, you can make a global change to all records or a select group of records in your 
database. For example, if a telephone area code changes, you can use the partial replace operation to globally 
replace the old area code with the new one. If only certain cities are affected by the new area code, you can filter 
by a query of records containing specified city names in their addresses.
When creating a global change, you define change operations on the General tab and filter the records affected 
by the global change on the Filters tab. You can save a global change and run it later as it is or with modifications.

Note: Visit our website at www.blackbaud.com for the latest documentation and information.
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General Tab

On the General tab, you select the fields to which you want to make changes and specify the type of change you 
want to make. 

Available fields. In the Available fields box, highlight the field you want to change and click Select. You can use 
the drop-down list, which defaults to <All fields>, to filter fields appearing in the box.
When you select a field, the Edit Change Parameters screen appears, on which you specify the type of global 
change. For more information, see “Global Change Operations” on page 118.

Apply changes to these fields. The change parameters you set appear in the Apply changes to these fields 
box. 

Find. Click Find to search subcategories in the Available fields box. The Find function searches only expanded 
categories.

Select. Use Select to choose fields to change. When you click Select, the Edit Change Parameters screen 
appears.

Remove. Click Remove to remove fields from a global change. You must highlight the field in the Apply changes 
to these fields box and then click Remove.

Criteria. Click Criteria to edit the item you select in the Apply changes to these fields box. The Edit Change 
Parameters screen appears, and you can edit the change parameters for the selected field.

Browse Changes. Click Browse Changes to view a sampling of selected changes. This button is active only if 
you are copying, moving, swapping, replacing, or partially replacing a field.

Note: You can also select a field in the Available fields box by double-clicking it.

Note: A static query is a query that reflects only the records and data present at the time it is created.
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Create a query of [ ] that have changes. Mark this checkbox to create a static query of all the records 
affected by the global change. For more information about queries, see the Query Guide.

Create control report. Mark this checkbox to view a list of records affected by the global change and 
information about records that could not be changed after the global change is run.

Automatically add new table entries. Mark this checkbox to add new table entries to code tables when 
copying, swapping, or moving data to a field that has values from a table. If you do not mark this checkbox, 
you may receive exceptions for fields that could not be changed; however, you may want to review the types 
of new entries being added before making a large global change that cannot be undone globally.

Create query of exceptions. Mark this checkbox to create a static query of records that the global change did 
not change. For more information about queries, see the Query Guide.

Cancel. Use Cancel to exit the Global Change screen without saving changes.
Preview Changes. Use Preview Changes to view change parameters before you process a global change. 
Change Now. Click Change Now to process a global change. Changes cannot be undone, so we strongly 

encourage you to preview changes prior to making them.

Filters Tab

You use the Filters tab to select the records in which you want to make a global change. On this tab, you can 
include all, selected, or a range of records. With some filters, you can also create a new query or use an existing 
query to filter by a specific group of records you want to globally change.

Open. When you highlight a filter in the grid and click Open, the Selected filter screen appears so you can edit 
filter settings. For more information about this screen, see “Selected Filter Screens” on page 117.

Note: If you are changing all records of one type in your database, you do not need to use the Filters tab.
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Clear All Filters. Click Clear All Filters to remove all filter parameters.
Filters. The Filters column displays the available filters for the selected record type to which you are making 

global changes.
Include. If you want to filter the records being changed, you choose Selected in the Include column for each 

filter you want to use. The Selected filter screen appears.
Selected Filters. The Selected Filters column displays your filter selections. You can click the binoculars in the 

field to open the Selected filter screen after you mark Selected in the Include column.
Cancel. Use Cancel to exit the Global Change screen without saving changes.
Preview Changes. Use Preview Changes to view change parameters before you process a global change. 
Change Now. Use Change Now to process a global change. Changes cannot be undone, so we strongly 

encourage you to preview changes prior to making changes.

Selected Filter Screens
Two types of Selected filter screens can appear with additional fields and options. Screen options vary depending 
on the filter type.

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may 
also be able to filter by a range or query.

All. If you mark All, you cannot designate specific filters.
Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a 

field, you can click the binoculars to search for information.

Query. If you mark Query, the Query name field appears for you to enter the name of the query by which to 
filter the report. In the field, you can click the binoculars to search for the query name.
To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more 
information about creating queries, see the Query Guide. 

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.

Note: You can click the binoculars in the Query name field to search for a query. If you cannot find the query 
you need, you can create a new query by clicking Add a New Query at the top of the Open Query screen.
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Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
OK. When you are finished specifying filters, click OK.
Cancel. If you do not want to save changes and want to return to the Filters tab, click Cancel.

Include. To filter, mark Selected.
Find. To search quickly for a particular item, you can enter full or partial text in the Find field. The first matching 

text in the filter box below the Find field appears highlighted.
Filters. The left box contains all the available filters. To select a filter, highlight it and click the right arrow button 

to move it to the Include these box.
Include these. This box contains the filters you have selected to include in the global change.
Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
OK. When you are finished specifying filters, click OK.
Cancel. If you do not want to save changes and want to return to the Filters tab, click Cancel.

Global Change Operations
The Edit Change Parameters screen appears when you highlight a field in the Available fields box on the General 
tab and click Select. In the Operation field you select to add, replace, partially replace, delete, increase, decrease, 
copy, move, or swap information in the field. Not all operations are available for every type of change. Depending 
on your selection in the Operation field, additional fields appear for you to enter information about the specific 
change. 
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For example, if you select the Replace operation, you must select or enter the current data you want to change in 
the Replace field and the new data with which you want to replace it in the With field.

For some record type fields, you can use the options Match case and Use pattern matching. 
Match case. If you mark Match case, the program searches for the value exactly as you enter it in upper case or 

lower case letters. For example, you can search for only “south” and not “South”.
Use pattern matching. With pattern matching, you can search using wildcards in place of a letter or letters. 

Use an asterisk (*) to match any number of characters or use a question mark (?) to match any single 
character. When you select Use pattern matching, the Find whole words only option is enabled. For 
example, if you want to change only text containing the word “South” and not “Southern”, you should mark 
Find whole words only.

Add

The Add operation adds a value to empty fields and either replaces existing current values with the new value or 
makes no changes to fields already containing a value.
• If you do not mark Overwrite existing value, only empty fields receive the new value. Fields with existing 

values are not modified.
• If you mark Overwrite existing value, the program replaces the existing values in the field and adds the new 

value to empty fields.
For example, if you are globally adding the class “Unrestricted net asset” to accounts. If you leave Overwrite 
existing value unmarked, “Unrestricted net asset” is added only to records with no selected class. Records with a 
selected class remain unchanged. If you mark Overwrite existing value, the program replaces the class value in 
every account with “Unrestricted net asset”, regardless of the original class value.
If you are adding an attribute that does not exist on a record yet, you must select Attribute from the Available 
fields box. If you want to add information to an attribute already existing on a record, you can select specific 
fields listed under a named attribute in the Available fields box.

Replace

The Replace operation searches for records that exactly match the value. For example, you can replace the value 
“One payment per invoice” with “One payment for all invoices” in the Payment Option field of a vendor record in 
Accounts Payable. Select “One payment per invoice” in the Replace field and “One payment for all invoices” in 
the With field. The program changes the payment option for all selected records in the global change.
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If you want to replace a field value with an empty value, enter the value you want to overwrite in the Replace 
field and leave the With field blank. You cannot leave the With field blank for required fields, such as the phone 
type field.

Partial Replace

The Partial Replace operation searches for records containing the selected value. In a partial replace global 
change, you cannot replace a value with a blank as you can with the Replace function. You must enter or select 
data in the Partially replace field. 

For example, you can use Partial Replace to change the phone area code 803 with a new area code 843 for 
records you have selected in a query. Because the phone number field you are changing contains the entire 
phone number, you must use Partial Replace to replace only the first three digits with the new value. The 
remainder of the phone number stays unchanged.

Delete

The Delete operation removes the specified value from the selected field.

For example, if your organization wants to clean up the database and remove account attributes that are no 
longer relevant. In an account global change, you can delete an entire attribute from all or specified account 
records by selecting Attribute in the Available fields box. On the Edit Change Parameters screen, you must enter 
an Attribute type. If you leave the other fields blank, the attribute is deleted from every record. If you enter 
information in the other fields, only the attributes containing the specified information are deleted from records.

Increase/Decrease

The Increase/Decrease operation increases or decreases numeric values in fields by an exact amount or 
percentage. When increasing or decreasing values by a percentage, you specify the number of decimal places to 
which the final value should be rounded. For fields containing a date value, you increase or decrease the date by 
a specified number of days, weeks, months, or years. Increases and decreases take into account months with 
different lengths and leap years.
For example, increasing by one day replaces 7/6/2004 with 7/7/2004 or 7/31/2004 with 8/1/2004. Decreasing by 
one week replaces 7/8/2004 with 7/1/2004 or 6/2/2004 with 5/26/2004. Increasing by one month replaces 
7/13/2004 with 8/13/2004 or 1/30/2004 with 2/28/2004 (the last day of the next month).

Copy

The Copy operation places the entire value of the source field into a compatible target field. To select the target 
field for the information you are copying, you click the binoculars in the Copy to field.

Note: Replace searches for records that exactly match the value, whereas Partial Replace searches for records 
that contain the value within the field entry.

Note: Partial Replace is not available for code table fields.

Note: When you delete a group of records with a global change, you can recover those records only from a 
backup. We recommend you make a valid and recoverable backup of your database before you begin the 
process.

Note: You cannot copy, swap, or move fields that represent more than one value.
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The Copy function always copies the specified value to empty target fields and either replaces existing current 
values with the new value or makes no changes to fields already containing a value.
• If you do not mark Overwrite existing value, only empty fields receive the copied value. Fields with existing 

values are not modified.
• If you mark Overwrite existing value, the program replaces the existing values in the field and adds the copied 

value to empty fields.

Swap

The Swap operation places the entire value from the source field into the target field, and the original value of 
the target field into the source field. In the Swap with field, click the binoculars to select the target field.

Move

The Move operation places the entire value of the source field into the target field and deletes the value from the 
source field. In the Move to field, click the binoculars to select the target field. 

The Move operation moves the specified value to empty target fields and either replaces existing current values 
with the new value or makes no changes to fields already containing a value.
• If you do not mark Overwrite existing value, only empty fields receive the new value. Fields with existing 

values are not modified.

• If you mark Overwrite existing value, the program replaces the existing values in the field and adds the new 
value to empty fields.

Globally Changing Records

You can use a global change to add, edit, or delete a wide variety of record types in your database without 
accessing each record individually. We strongly recommend you completely back up your database before 
performing a global change.
Understanding the different record types is essential to successfully completing a global change. Selecting a 
specific record type instructs the program to include only records for that record type in the global change. The 
program globally changes every record of that type unless you use filters on the Filters tab to limit changes to 
only certain records.
Although this section contains a scenario procedure for performing a partial replace global change, the procedure 
is similar for all global change functions.

Note: You cannot delete, move, or replace required fields with a <blank>. You can only copy unique required 
fields.

Note: You cannot move a required field.

Warning: Before performing a global change, we strongly recommend you back up your database. For more 
information about creating backups, see the Database Administration Guide.
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Globally changing information on a record using partial replace

1. On the Globally change records page of Administration in Accounts Payable, select Vendors from the 
tree view.

Scenario: The telephone company has added a new area code in your state. The old area code 803 remains in 
use in many cities but will be replaced by 843 in other cities. You have determined which cities are affected by 
the change and have created a query containing vendors in those cities. Now you want to globally change your 
vendor records to reflect the new area code.
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2. Click New Change on the action bar. The Global Change - Vendor screen appears. In the tree view, click 
the plus sign next to Vendor Address to expand the field list.

3. Under Vendor Address, click the plus sign next to Phone to expand the field list. Highlight Number and 
click Select. The Edit Change Parameters screen appears.

4. In the Operation field, select “Partial Replace”. In the Partially replace field, enter “803”. In the With 
field, enter “843”. 
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5. Click OK. You return to the Global Change - Vendor screen. The change parameters appear in the Apply 
changes to these fields box.

6. To create a query of records that are changed, mark Create query of vendors that have changes. To 
create a query of records that cannot be changed, mark Create a query of exceptions.

7. Mark Create control report and select “Preview report”. Later, when you run the global change, the 
control report will appear after you view change statistics. You can print the report from the Preview 
Report screen.

8. Select the Filters tab.
9. Select the row for the Vendors filter and click Open on the action bar. The Selected Vendors screen 

appears.

Note:  For more information about queries, see the Query Guide.

Note: If you need to create a query, on the Open Query screen you can click Add a New Query. For more 
information about creating queries, see the Query Guide.
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10. Mark Query. Click the binoculars to find the query by which you want to filter. Select it on the Open 
Query screen and click Open. It appears in the Query name field. 

11. Click OK. You return to the Global Change screen.
12. Click the Save button on the toolbar. The Save Global Change As screen appears.

13. In the Name field, enter a name for your global change. In the Description field, enter a description.
14. Click Save. You return to the Global Change screen.
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15. To check the records before globally changing them, click Preview Changes. The Preview Modifications 
screen appears.

16. To remove any records from the global change process, unmark the checkbox in the Change? column. To 
run the global change, click Change Now.

17. When you run the global change, you are prompted to save the exception query and query of records 
changed. On the Save Static Query screens, enter a name and description and click Save.

18. When the global change is complete, a screen appears showing the global change statistics. 

19. Click Close. The Global Change Control Report appears. To print the report, click the print button. 
Close the report when you are finished viewing it. You return to the Global Change - Vendor screen.

20. To close the global change, select File, Close.

Note: Once you close the control report, you do not have another opportunity to view it or print it.
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Globally adding an attribute to a record

1. On the Globally change records page in Administration in General Ledger, select Projects from the tree 
view.

2. Click New Change on the action bar. The Global Change - Project screen appears. In the tree view, click 
the plus sign next to Attributes to expand the field list.

Note: When adding a new attribute to a record, you must use Attribute in the Available fields box. If you want 
to add information to an attribute already existing on a record, you can select specific fields listed under a 
named attribute in the Available fields box.



128 CH A PT E R  
3. Under Attributes, select Attribute and click Select. The Edit Change Parameters screen appears.
4. In the Operation field, select “Add”. In the Value column next to Attribute type, select “Grant Manager”. 

If you want to specify a Description, select one in the Value column; however, be aware this description 
will appear on every record affected by the global change. 

5. When you are finished specifying change parameters, click OK. You return to the Global Change - Project 
screen. The change parameters appear in the Apply changes to these fields box. 

6. To create a query of records that are changed, mark Create query of [ ] that have changes.

To create a query of records that cannot be changed, mark Create a query of exceptions.
7. Mark Create control report and select “Preview report”. Later, when you run the global change, the 

control report will appear after you view change statistics. You can print the report from the Preview 
Report screen.

Note: For more information about queries, see the Query Guide.
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8. Click the Save button on the toolbar. The Save Global Change As screen appears.

9. In the Name field, enter a name for your global change. In the Description field, enter a description.
10. Click Save. You return to the Global Change screen.
11. To check the records before globally changing them, click Preview Changes. The Preview Modifications 

screen appears.

12. To remove any records from the global change process, unmark the checkbox in the Change? column.
13. To run the global change, click Change Now.

When you run the global change, you are prompted to save the exception query and query of records 
changed. On the Save Static Query screens, enter a name and description and click Save.

Note: If you added a specific attribute description on the Edit Change Parameters screen, you may want to 
mark only records that need that description. After you have finished running this global change, you can run 
this same global change again, change the description, and select different records to globally change.
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14. When the global change is complete, a screen appears showing the global change statistics. 

15. Click Close. The Global Change Control Report appears. To print the report, click the print button. 
Close the report when you are finished viewing it. You return to the Global Change - Project screen.

16. To close the global change, select File, Close.

Note: Once you close the control report, you do not have another opportunity to view it or print it.
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By establishing security rights for your users, you can ensure the validity, consistency, and confidentiality of your 
data and determine which users can change or delete important records. By limiting viewing rights, you can 
control who sees sensitive information.
Security is based on groups and users that are members of groups. You identify the records and functions users 
access by creating a group and assigning users to that group. When a user logs into a program, the records and 
functions to which the user has rights are accessible and all other records and functions are unavailable.
We recommended reviewing the components and privileges of each program to determine the best security 
configuration for your organization. When security is properly set up, you are ensured that users are accessing 
only the areas you allow.

Accessing Security
You can access security by clicking Set up system security on the Administration page of any program.

Accessing security
1. From the navigation bar, click Administration. The Administration page appears.
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2. Click Set up system security. The Set up system security page appears.

3. To return to the Administration page, click Back.

Supervisor Procedures
We ship the program with “admin” as the Supervisor password. The Supervisor user name can access all areas of 
the program. For security purposes, it is very important that you change the Supervisor password immediately. 
When you log into your Financial Edge database as Supervisor, you have rights to perform all functions, such as 
globally changing or deleting vendor records. Because the Supervisor’s rights are so vast, we recommend you use 
a login with more limited security rights for routine work within the database. Doing so ensures you stop to 
consider the implications before making changes that may permanently alter your data. 

There is only one Supervisor login; however, Supervisor rights can be assigned to other users. We recommend at 
least two users have Supervisor rights. Each user with these rights can access all areas of the program. These 
users should also know the password for the Supervisor user name. 

Note: The Supervisor and users with Supervisor rights have full access to all areas of the program. We 
recommend you limit the number of users with Supervisor security rights and knowledge of the Supervisor 
password.
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Changing the Supervisor password
Once the Supervisor password is changed, we recommend keeping it in a secure location accessible by at 
least two users.
1. From the Set up system security page, select Supervisor and click Open on the action bar. The 

User - Supervisor screen appears.

2. Enter a new password in the Password field. The password must be at least eight characters, and include 
one alphabetic character and one non-alphabetic character. 

3. Reenter the password in the Confirm field.
4. To return to the Set up system security page, click Save and Close.

Assigning Supervisor rights
1. From the Set up system security page, select the user to whom you want to assign Supervisor rights.

Note: If you log in as Supervisor, you can change the password from anywhere in the program by selecting 
Edit, Change Password from the menu bar.

Note: Only a user with Supervisor rights can access all areas of the program.
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2. On the action bar, click Open. The User screen for the selected user appears.

3. In the Groups for <Organization Name> frame, mark Supervisor rights.
4. To save the change and return to the Set up system security page, click Save and Close.

Passwords
Each user must have a password to access the program. We recommend a unique password for each user. The 
Supervisor, or a user with Supervisor rights, can define and edit passwords from each user record. 
A Supervisor can also grant users the right to change their own passwords by marking the User can change 
password option on the user’s security record. To change their password, the user needs to log into The Financial 
Edge and then select Edit, Change Password from the menu bar. 
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Changing a user’s password
1. From the Set up system security page, select a user and click Open. The User screen for the selected user 

appears.

2. In the Password field, delete the current password and enter a new password. The password must be at 
least eight characters, and include one alphabetic character and one non-alphabetic character.

3. Re-enter the new password in the Confirm field.

4. If entries in both the Password and Confirm fields are not identical, the following message appears when 
you try to save the record. 

5. Click OK and re-enter the new password in the Password and Confirm fields.
6. To save the changes and return to the Set up system security page, click Save and Close.

Note: Only the Supervisor or a user with Supervisor rights can give a user the right to change the password. 
Users who have the right to change their passwords can do so from anywhere in the program by selecting Edit, 
Change Password from the menu bar.
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Security for Groups
Security is based on groups and users that are members of groups. You identify the records and functions users 
access by creating a group with specific rights and assigning users to that group. When a user logs into a program, 
the records and functions to which the user has rights are accessible and all other records and functions are 
unavailable.
The first step in establishing security is to create security groups. Groups are composed of users who perform 
similar tasks or have similar responsibilities and, therefore, have similar security needs. Give the groups 
descriptive names you can easily identify, and then assign rights to a group based on the areas of the program to 
which you want its members to have access.

For new installations of the program, and when you add a new database, you have three ready-to-use security 
groups to help you start quickly with maintaining system security. These groups are accessible on the Set up 
system security page. You can assign users to the Reporting Only group if they need to create report parameter 
files and run reports; the Read Only group if they need to view data in the system; and the Data Entry group if 
they need to view, enter, and manipulate data but not administer the system. The pre-created groups do not 
include users. You must create users and assign them to the groups. It is very important to review these groups to 
ensure they are appropriate for your organization.

Managing Security Groups

By creating a security group and assigning users, you determine what areas of the program users can access. 
Properly setting up security ensures that users are accessing only the areas that you specify. We recommend 
thoroughly reviewing the privileges for each program.
You can create as many different groups as you need. As users are added to security, you can make them 
members of groups that grant them the appropriate levels of access.

Adding a security group

Note: Before you begin setting up Security, you should change the Supervisor password from the default.

Note: Initially, a new security group has access to all areas of the program except those areas available only to 
users with Supervisor rights. For more information about Supervisor rights, see “Supervisor Procedures” on 
page 133.

Note: You can also access the New Group screen by double-clicking Groups in the tree view.
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1. From the Set up system security page, click New Group on the action bar. The New Group screen 
appears.

2. In the Group name field, enter a name for the user group. This name must be unique and no longer than 
30 characters. We recommend you use a descriptive name for each group that you can easily remember.

3. In the Description field, enter a description for the user group.
4. In the Group type field, select the type of group you want to create. Your selection changes the options 

that appear on the Group Privileges tab.
5. In the System Components box, select a program or component. To restrict users from accessing the 

program, unmark the checkbox. With the box marked, a list of security privileges appears in the 
Privileges box on the right.

6. In the Privileges box, unmark the checkbox to prevent the group from accessing that area of the 
program. Leave the checkbox marked to allow the group access.

Note: If you make a user with Supervisor rights a member of a security group, his Supervisor rights are not 
affected.

Note: If no additional security rights are available for the selected privilege, the Options button is disabled.
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7. To define additional levels of security, select a privilege and click Options. The Security Options screen 
appears.

8. In the box on the left, select a security option. If the option has additional security privileges, they appear 
on the right.

9. Mark the checkbox in the View, Add, Edit, and Delete columns for the program areas the group can 
access. 

10. Some privileges have miscellaneous options. Mark a checkbox to give the group access or unmark to deny 
access to a function.

11. When you finish, click OK to return to the New Group screen.
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12. Select the Group Members tab.

Note: If you have not yet created users, the Not members box is blank.
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13. Select a user from the Not Members box. Click the single right arrow to move the user to the Members 
box. Click the double arrows to move the entire list.

14. To return to the Set up system security page, click Save and Close.



142 CH A PT E R  
Editing security group information
You can change the members and rights of a security group. The changes will not take effect until the 
member signs out and logs back into the program.
1. From the Set up system security page, select a group and click Open. The Group screen appears.

2. On the Group Privileges tab, you can edit information in the System Components and Privileges boxes. 
To edit security options, select a privilege in the Privileges box and click Options.



S E C U R I T Y 14
3. On the Group Members tab, you can add and remove users from security groups. Click the single arrow 
to move an individual or the double arrows to move all users.

4. To return to the Set up system security page, click Save and Close.
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Deleting a security group
Deleting a security group does not delete the users of the group. You can re-assign the group’s members as 
members of other groups.
1. From the Set up system security page, select the group to delete and click Open. The Group screen 

appears.

2. On the toolbar, click the Delete button. A confirmation message appears.
3. To delete the security group and return to the Set up system security page, click Yes.

Printing a security group profile report
Before you delete a security group or make significant changes, we recommend you print a security group 
profile.
1. From the Set up system security page, select the group whose profile you want to print. 
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2. Click Open. The Group screen appears.

3. To preview the report, select File, Print Preview.
4. To print the report, select File, Print. 
5. To return to the Set up system security page, select File, Close.

Understanding Group Privileges
We recommended thoroughly reviewing the privileges of each program to determine the best use for your 
organization. When security is properly set up, you are assured that users access only the areas you allow.
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When you select a program, items that comprise it appears in the Privileges box. These are the same items that 
appear on the navigation bar in the program shell.

If you select Records in the General Ledger Privileges box and click Options, the Security options screen appears. 
In the Record Types box, the record types for General Ledger appear. These are the same items that you see 
when you click Records on the navigation bar.

Note: If you do not use a certain record type, you can unmark the checkbox in the Record Types column. The 
record type will not appear in Records.
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Select Account in the Record Types column. The Accounts Privileges box lists the tabs on an account record. 

For each option, mark View, Add, Edit, or Delete to assign group rights for that option. For example, if you 
unmark Add for the Notes tab, the group cannot add notes to an account record; however, the group can view 
and edit notes. N/A indicates an option is not available for the selected tab.
View. Mark View to allow a group to see the information in the specified record but not make changes.
Add. Mark Add to allow a group to add a record of the specified item, but not make changes.
Edit. Mark Edit to allow a group to make changes to the specified record.
Delete. Mark Delete to allow a group to delete the specified record.
The Miscellaneous Options box lists additional functions to which you can give the group access. 
Activate/deactivate accounts is a miscellaneous option for an account record. Marking the box gives the group 
rights to activate and deactivate account records. Unmarking the box denies the group the ability to do this. 

Security for Shared Components
Shared components are portions of The Financial Edge shared among programs. Shared components consist of 
Shared Tables such as title and state tables; Shared Components such as system security, banks, and encryption 
for personal information; and Shared Configuration Information such as international settings.
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If you select Shared Components from the System Components column, you can view the items that are shared 
among programs. The system components listed depend on the programs you have installed.
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Banking Security

Select Bank Accounts from the Shared Component Privileges box and click Options to view the Security Options 
screen. In the Bank Accounts column, select Bank Account Information to see the tabs that appear on a bank 
account record.

For each tab, mark View, Add, Edit, or Delete to assign group rights to that tab. For example, if you unmark Add 
for the Notes tab, the group cannot add notes to a bank account record; however, the group can view and edit 
notes. N/A indicates an option is not available for the selected tab.
View. Mark View to allow a group to see the information in the specified record but not make changes.
Add. Mark Add to allow a group to add a record of the specified item, but not make changes.
Edit. Mark Edit to allow a group to make changes to the specified record.
Delete. Mark Delete to allow a group to delete the specified record.

Personal Information Encryption

The Financial Edge encrypts personal information such as Social Security, tax ID, and bank account numbers. This 
means that this information is always masked on screens, reports, queries, and exports unless a user has security 
rights to add, edit, delete, view, or output personal information. It is very important that your organization 
considers best practices for managing personal information before you grant security rights. 
To protect personal information in your database, it is recommended that your organization:  
• Restricts access to personal information to only users with a specific need to view it. 
• Ensures that users in contact with personal information understand their responsibilities. 
• Does not send email containing personal information. 
You should plan for processes that require users to view personal information. For example:

Note: Personal information refers to Social Security numbers and bank account numbers.
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• During data entry, users must enter or import Social Security, bank account, and tax ID numbers on records. 
Users with security rights can view these numbers while entering them in fields, but the numbers are masked 
once the record is saved or reopened to edit.

• Checks and EFT notices will always mask bank account numbers or Social Security numbers. You should have 
strict controls on who can access these documents.

Select Personal Information from the Shared Component Privileges box and click Options to view the Security 
Options screen. 

Three options appear:

• Personal Information Data Entry — Marking this option allows a group to add, delete, or edit personal
information on records, on Fast! datasheets, and via the API. They can also globally change or import personal
information but they cannot output personal information.
Once the record or datasheet is saved, personal information is masked so the group cannot view it. When
editing personal information, users must delete the entire masked value before they can enter a different
value.

• Personal Information Output — Marking this option allows a group to output personal information through
mailings, reports, export files, import files, and the API. They cannot add, remove, edit, or view personal
information on records or datasheets. If users do not have this right, they can output personal information, but
it is always masked.

• Personal Information View — Marking this option allows a group to view personal information on records,
datasheets, and via the API, but they cannot add, delete, edit, or output personal information.

Security for Users
An individual user’s security privileges are determined by the group. You add users to security and then define 
their levels of access by assigning them to security groups. Using groups ensures data consistency, integrity, and 
confidentiality by limiting access to records and functions to the users who need it. A user can be a member of 
multiple groups.

Note: All three options are marked automatically for any user with supervisor rights. 



S E C U R I T Y 15
Adding a user to a security group

1. From the Set up system security page, click New User on the action bar. The New User screen appears.

2. In the User name field, enter the name the user will use to log into the program.
3. In the Description field, enter a full name or other information to identify the user.
4. In the Connection Options frame, mark Use FE7 Authentication if you want a user’s log in information for 

The Financial Edge to be separate from his or her workstation log in information. 

5. If you mark Use FE7 Authentication, enter the user’s password in the Password field. Enter the password 
again in the Confirm field.

6. Mark Use Windows Authentication if you want a user’s log in information for The Financial Edge to be 
based on his or her Windows log in information. When users logged into a workstation through their 
Windows authentication access The Financial Edge, the Windows information is used to automatically 
log the user into the program.
To associate a user’s Windows authentication information with The Financial Edge, use the Login field to 
locate that user’s account on your network.

a. Click the binoculars in the Login field. The Select User Account screen appears.
b. In the List Names From field, select the system to which the user you want to select belongs.

Note: You can also access the New User screen by double-clicking Users in the tree view.

Note: The actual password does not display in the Password and Confirm fields. For privacy, only asterisks 
appear.

Note: If you mark both the Use FE7 Authentication and Use Windows Authentication checkboxes, this only 
affects whether or not a password is stored for the user. The Financial Edge always tries Windows 
authentication first, but if for some reason that fails, The Financial Edge User name/Password screen appears.
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c. All members of the selected system appear in the Names box. Select the user you want to specify 
and click Add. The name appears in the Add Name field.

d. Click OK. You return to the Security User screen where the user now appears in the Login field.

7. In the User Type field, select “User can only access The Financial Edge”, “User can only access online 
modules”, or “User can access The Financial Edge and online modules”.

8. In the Groups for <Your Organization> frame, to assign the user full access to the programs, mark 
Supervisor rights. To restrict access to certain security groups, mark Selected group rights.

9. If you mark Selected group rights, select the user’s group from the Not a member of box and click the 
single right arrow to move the group to the Member of box.

10. To grant the user the right to change his password, mark User can change password. For more 
information about changing passwords, see “Passwords” on page 135.

11. To grant the user the right to change his options, mark User can change User Options. To set options, 
click Set this user’s options after saving the user to open the user’s options screen. At the bottom of the 
Options screen, you can click Copy From to copy another user’s options. Using this feature helps keep 
data consistent.

12. If you have the optional module Advanced Security, select the Account Security tab.

13. In the Account access field, select the access level you want the user to have. If you select “Allow access 
to selected Accounts” or “Prevent access to selected Accounts”, mark Query, Range, or Selected.
If you mark Query, enter a query name in the Query Name field or click the binoculars to locate the 
query.

If you mark Range, in the Start Account Number column, enter a starting account number. In the End 
Account Number column, enter an ending account number. The account descriptions appear from the 
account records. 
If you mark Selected, enter an account number in the Account Number column. Repeat for each account 
the user will be able to access.

Note: Windows Authentication does not apply to Web applications.

Note: With the optional module Advanced Security, you can use masking for a range of selected accounts. You 
can also mask one or more characters of an account segment using the asterisk in place of the character. For 
more information about masking, see the Configuration Guide for General Ledger.
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14. If you have the optional modules Advanced Security and Projects and Grants, select the Project Security
tab to define additional security for projects.

15. In the Project access field, select the projects you want the user to be able to access. If you select “Allow 
access to selected Projects” or “Prevent access to selected Projects”, mark Query, Range, or Selected. If 
you mark Query, in the Query Name field, enter a query name or click the binoculars to locate the query.
If you mark Range, enter a starting project number in the Start Project Number column or click the 
binoculars to locate a number. In the End Project Number column, enter an ending project number or 
click the binoculars to locate a number. The project descriptions appear from the project records.
If you mark Selected, enter a project number in the Project Number column. Repeat for each project the 
user will access.

16. If you have the optional module Advanced Security and the program Accounts Payable, select the 
Signature Security tab.

17. Mark the Choices? checkbox to make a signature available for use.
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18. If you have the optional modules WebPurchasing or WebInvoicing, select the Online Security tab.

19. In the Online Systems box, mark WebPurchasing to set user security for your WebPurchasing users.
20. In the Department field, select the user’s department. If the department is not listed, you can click 

Department to access the Department table and add a new entry, or edit existing table entries.
21. To allow the user to approve or reject requisitions, mark Can approve Requisitions. Marking this option 

allows the user to be added to WebPurchasing approval rules.
22. To allow the user to approve his own requisitions, mark the Can self-approve Requisitions.

To restrict the amount a user can self-approve, enter the maximum amount in the Requisition self 
approval limit field.

23. In the Create Receipts frame, select one of the following options:
• Cannot create Receipts
• Can create Receipts for own Requisitions
• Can create Receipts for all Requisitions

24. To allow the user to view all requisitions, mark Can view all Requistions.
25. To allow the user to edit other users’ information on the My Account page, mark Can edit My Account 

information for other users.
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26. If you have the optional module WebInvoicing, mark the Web Invoicing checkbox.

27. Mark the Can approve Invoice Requests checkbox to allow the user to approve invoice requests. Marking 
this option allows the user to be added to WebInvoicing approval rules.

28. Mark the Can self-approve Invoice Requests checkbox to allow the user to self-approve invoice requests. 
To restrict the amount a user can self-approve, enter the maximum amount in the Invoice Request self 
approval limit field.
Invoice requests under self-approve limits are automatically approved up to the self-approval limit.

29. To allow the user to view invoice requests created by all WebInvoicing users, mark Can view all Invoice 
Requests.

30. To allow the user to change their GL distribution on the My Account page in WebInvoicing, mark Can 
change GL distribution in My Account.

31. To allow the user to edit other user’s information on the My Account page in WebInvoicing, mark Can 
edit My Account information for other users.

Note: If the approver has an account restriction in Security, he will not be able to approve an invoice request 
for a category that contains that restricted number. Be sure to review their account security restrictions after 
establishing the account numbers in their Expense Categories.

Note:  Invoice requests under self-approve limits are automatically approved up to the self-approval limit.
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32. If you have the optional module Advanced Security, select the Employee
Security tab.

33. In the Employee access field, select the employees you want the user to be able to access. If you select
“Allow access to selected Employees” or “Prevent access to selected Employees”, mark Query, Range, or
Selected.
If you mark Query, in the Query Name field, enter a query name or click the binoculars to locate the
query.
If you mark Range, enter a starting employee in the From Employee column or click the binoculars to
locate an employee. In the To Employee column, enter an ending employee or click the binoculars to
locate an employee. The employee IDs appear from the employee records.
If you mark Selected, enter an employee in the Employee Name column. Repeat for each employee the
user will access.

34. To save the user security settings and return to the Set up system security page, click Save and Close.
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Editing the security rights of a user
You can change the security rights of a user by changing the security groups to which the user belongs. You 
can add or remove a member from a group either directly from the user’s record or through the group 
record.
1. From the Set up system security page, select a user and click Open on the action bar. The User screen for 

the selected user appears.

2. To change the user’s group, select a group to change and use the arrows to move groups between the 
Not a member of and Member of boxes.

3. To save the changes and return to the Set up system security page, click Save and Close.
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Printing a security user profile report
You can print a security profile of the user before you delete the user name from security. 
1. From the Set up system security page, select a user and click Open. The User screen for the selected user 

appears.

2. To preview the report, select File, Print Preview.
3. To print the report, select File, Print. 
4. To return to the Set up system security page, select File, Close.

Deleting a user

You can delete a user from a security group when a user’s responsibilities change or a user leaves your 
organization. The user can no longer log into the system when deleted from security. However, the individual’s 
history of activity in the program with his user name attached is not removed from the database.
However, before deleting a user, you should log in as the user and check the settings and rights:
• If a user has action reminders scheduled and is deleted, the reminders remain active but never occur. You 

should consider reassigning the action reminders to another user.
• The user may have created queries and exports that are restricted to other users. Open each of the user’s 

queries, select Tools, Query Options, and mark the checkboxes for other users to run and modify the query. 
Open each of the user’s exports, select Tools, Export Options, and mark the checkbox for other users to run 
and modify the export.

• The user may have restricted reports and mailings from other users. Open each of the user’s reports and 
mailings, select File, Save As, and mark the checkboxes for other users to run and modify the report or mailing.
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Deleting a user from Security

1. From the Set up system security page, select the user to delete from the tree view.

2. On the action bar, click Delete. The record opens and a message appears asking if you want to change the 
user name and save the record before deleting it.

3. To delete the user, click No.
To close the message and edit the record, click Yes.

Advanced Security

With the optional module Advanced Security, you can grant users view-only access to the database and you have 
additional security options on user records.

View-Only Users

View-only user licenses are an optional feature with Advanced Security. This license allows users to view data, 
without having rights to edit or enter it, and to create and modify report and queries. Users have full rights to 
Dashboard, Plug-Ins, Reports and Query and limited access to Records, Banks, Visual Chart Organizer and Journal 
Entry. The view-only user is not permitted in Administration and Configuration.

To create a view-only user, mark User can view data but cannot make changes, which appears on the User 
Information tab.
A view-only user can be restricted by group rights. If you add a view-only user to a group with rights to Accounts 
Payable only, he will be restricted from viewing data in other programs. Adding a view-only user to a group with 
add, edit, or delete rights to records will not increase the user’s rights.

Note: We strongly recommend you print a security profile of the user before you delete him from security. For 
more information about the profile, see “Printing a security user profile report” on page 158.

Note: To delete the user and still be able to reuse the user name, change the user name before deleting.

Note: The User can view data but cannot make changes checkbox is visible only if view-only and Advanced 
Security are installed.
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Plug-ins are specially built applet extensions of The Financial Edge. A Plug-in ‘plugs in’ to The Financial Edge, 
opening the door to a wide range of custom functionality. Plug-Ins can be as simple as an HTML page or a 
Microsoft Office document or as complicated as a multi-level ActiveX document or interactive spreadsheet. This 
flexible technology makes adding custom applications and extensions directly to The Financial Edge easy. 
Plug-Ins share the database connection and runtime code resources with The Financial Edge, making them an 
excellent choice for adding custom functionality without an extensive API application.

Update Accounts
The Update Accounts plug-in synchronizes Accounting for Nonprofits version 6.4 modules to recognize new 
accounts and/or projects that are entered in General Ledger 7. Before converting, we recommend that you run 
the Update Accounts plug-in available on the Plug-Ins page.

Update Accounting for Nonprofits modules with General Ledger 7 projects and accounts
1. From the navigation bar, select Plug-Ins. The Plug-Ins page appears.
2. From the Plug-Ins page, click Update Accounts. The Update Accounts page appears.

3. To synchronize any changes to your General Ledger 7 accounts or projects with your existing 6.x 
applications, mark Update Accounts and/or Update Projects.

4. To run this utility, click Update.
5. When your accounts and projects are updated, click Back to return to the Plug-Ins page.

Initialize Accounts Receivable and Cash 
Receipts Systems
After upgrading to The Financial Edge, run the Initialize Accounts Receivable and Cash Receipts Systems plug-in 
to convert your data from Accounts Receivable 6.x or Miscellaneous Cash Receipts 6.x to version 7.
For more information, see the Conversion Planning Guide and Conversion Guide for The Financial Edge.

View Locked Records/Processes
The Locked Record Viewer shows you database connections and record locks. You can access the Locked Record 
Viewer from the Plug-Ins page of any program.
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View locked records/processes
1. From the Plug-Ins page, click Locked Record Viewer. The Locked Record Viewer screen appears.

2. To return to the Plug-Ins page, click Back.

Convert Billing Years

The Convert Billing Years plug-in converts billing cycles from Student Billing 6.x to Student Billing 7. The 
converted billing cycles contain the same functionality as the original billing cycle. Once the plug-in is run, you can 
not run it again.

Convert billing cycles
1. From the navigation bar, select Plug-Ins. The Plug-Ins page appears.

Note: If you have billing cycles created, you should not run this plug-in.
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2. From the Plug-Ins page, click Convert Billing Years Utility. The Convert Billing Years utility screen appears.

3. In the School to use field, select a school that contains Student Billing 6.x. This field determines what 
schools billing cycles are copied from Student Billing 6.x to Student Billing 7.

4. In the billing cycles grid, mark the Create? checkbox to select the billing cycles for conversion.

Note: The School to use field does not appear on this screen if only one school was present in Student Billing 
6.x.
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5. In the Product and Billing Items grid, mark the Update? checkbox next to the specific product and billing
items you want to update.

6. To convert the selected billing cycles and update the selected product or billing items, click Update.
7. To return to the Plug-Ins page, click Back.

Link to Other Blackbaud Systems
We have included a plug-in you can use to create links, which are like shortcuts, to other programs. F
To create favorites to other programs, click Create Links to Blackbaud Systems on the Plug-Ins page. Once 
created, the links are housed in the Blackbaud Systems group on the navigation bar.

 Create links to other Blackbaud systems

1. From the navigation bar, select Plug-Ins. The Plug-Ins page appears.
2. From the Plug-Ins page, click Create Links to Blackbaud Systems. The Create Links to Blackbaud Systems

screen appears.

3. By default, each system installed on your computer appears next to a marked checkbox. If you do not
want to create a link for a specific system, remove the corresponding check mark.

4. To add a Blackbaud system to the navigation bar, click Create Links.
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5. When you click Blackbaud Systems in the navigation bar, a list of links to the other systems appears. Click 
a link to display the program components in the shell.

View Database Connections
The Database Connection Viewer shows you which users are connected to the database. You can access the 
Database Connection Viewer from the Plug-Ins page of any program.

View database connections
1. From the Plug-Ins page, click Database Connection Viewer. The Database Connection Viewer screen 

appears.

2. To return to the Plug-Ins page, click Back.

Patron Edge Import Utility
Once you run the Post to GL wizard in The Patron Edge and create an export file of transaction information to 
post to General Ledger, you can access The Financial Edge and import the transaction information.
When you import the transactions, you create a journal entry batch to be posted. Typically, the export file 
created in The Patron Edge by the box office staff is forwarded to the business office to be imported into 
The Financial Edge.
For more information about integrating with The Patron Edge, see the The Patron Edge and The Financial Edge 
Integration Guide.
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Import Patron Edge Transactions
To import transaction information, the export file generated from The Patron Edge must be accessible.
1. From The Financial Edge, click Plug-Ins on the navigation bar. The Plug-Ins page appears.
2. Click Patron Edge Import Utility.

3. In the Import File field, click the browse button and select the *.csv file of transaction data generated 
from The Patron Edge.

4. In the Exception File field, an output location and name for the file is automatically displayed. By default, 
the file is saved in the same location as the import file and “exception” is added to the filename. To 
change the default, click the browse button and enter a name and output location for the*.csv exception 
file.

5. In the Batch Description field, enter a description to identify the batch of transactions that will appear in 
Journal Entry as a result of the import. A default description is provided with the date and a “Patron 
Edge” designation.

6. When you are ready to import the transactions and create a batch in Journal Entry, click Create Batch. 
Once processing is complete, you can access the Journal Entry page in General Ledger to view and post 
the new batch of transactions. For information about posting, see the The Patron Edge and The Financial 
Edge Integration Guide. If exceptions are found, review the exception file and makes changes as needed.

Update Cached Record Balances
You can run the Update Cached Record Balances plug-in to calculate the current account balances in the Balance 
and Balance with scheduled activity fields that appear in the status bar of student, individual, and organization 
records. If you do not run this plug-in, Student Billing automatically calculates the balances when the student, 
individual, or organization record is opened for the first time after upgrading, which can slow the data entry 
process. 
We recommend that you start the plug-in on a separate machine that can run uninterrupted because you will not 
be able to navigate away from the plug-in once it starts running. 

Update cached record balances
1. From the Plug-ins page, click Update Cached Record Balances. The Update Cached Record Balances page 

appears.

2. Mark Run plugin.
3. Click Update. The Update Cached Record Balances screen appears displaying the progress of the 

calculations.
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4. When finished, a completion screen appears displaying the number of records processed. Click OK to exit
and return to the Plug-Ins page.

View Product Details
Using the Product Details plug-in, you can generate a text file that includes information about your product 
installation. For example, you can use this plug-in to find the number of user licenses your organization owns.

View product details 
1. On the Plug-Ins page, click Miscellaneous, and then Product Details. The Product Details page appears.

2. Click Create. A text file appears displaying the server name, server properties, organization name,
country, serial number, database, number of users, and the programs and modules installed.
The text file is saved automatically to the root of your hard drive (for example, C:\BBDetails7.txt).

3. When you close the text file, you return to the Product Details page.
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Update the Payers and Statements Tab on 
Student Records
Using the Statements and Payers utility in Student Billing, you can refresh your database to clean up Statement 
and Payers tab issues. You select the query of student records to update, whether to clear the current settings on 
the Payer or Statement tabs, and which relationships should be payers. 

Update the Payers and Statements tab on student records
1. From the Plug-ins page in Student Billing, click Miscellaneous, then Statements and Payers Utility. The

Statements and Payers Utility page appears.

2. In the Query field, select the query of student records whose Statements and Payers tab you want to
update.

3. In the Update section, you have two options.
• Mark Payers tab for students marked to assign each charge to a payer's account to update the Payers

tab for records included in the query.
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• Mark Statements tab to update the Statements tab for records included in the query.
4. If you marked Payers tab for students marked to assign each charge to a payer's account the Clear

existing entries on the payers tab option is enabled. Mark this option to clear anything that currently is
on the Payers tab for the records in the query.

5. In the Mark the following relationships as payers box, mark each relationship type you want to make
payers for the student.
If the student record has multiple relationships specified in the Mark the following relationships as
payers box, all that meet the criteria are added the student’s Payers tab and the payment responsibility is
divided among all the relations. For example, you mark Mother and Father. A student’s mother and
father are both added as payers with 50% payment responsibility.
If a student has more than one relation of a selected type, the first entry on the Relationships tab is made
a payer. For example, if you have two records whose relationship is “Mother” to the child, the first record
listed in the grid is made the payer on the Payers tab.
If the student has “Assign each charge to this student’s account” selected in the Billing option field on the
Bio 1 tab, this update will not change his Payers tab.

6. If you marked Statements tab, the Clear existing entries on the statements tab option is enabled. Mark
this option to clear anything that currently is on the Statements tab for the records in the query.

7. In the Mark these relationships as statement recipients box, mark each relationship type you want to
make statement recipients for the student.

8. Mark Run plugin and click Update. The process runs and then a completion screen appears. Click OK to
return to the Miscellaneous page.

Convert Your Student Billing 6.4 Data
The conversion of your Student Billing 6.4 data does NOT occur automatically. You must manually install the 
conversion utility and convert your data after updating or installing the latest version of The Financial Edge or 
The Education Edge. Before attempting to run the conversion, make sure you have reviewed the pre-conversion 
considerations and followed any recommendations that apply to your organization.
For more information, see the Conversion Planning Guide and Conversion Guide for The Financial Edge.
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Reset the Registry
The Reset Registry plug-in resets user preferences to the default installation settings. The registry reset applies to 
only the workstation the plug-in is run on. 
Changing registry settings incorrectly can cause serious problems that may be irreversible without reinstalling the 
program. You must back up your database before making any registry changes. Blackbaud is not responsible for 
damage resulting from incorrect use of the Reset Registry plug-in.

Reset the registry

1. From the Plug-ins page, click Miscellaneous, then Reset Registry. The Reset Registry page appears.

2. To reset all options in the database, mark Current Database.
3. To reset only specific options, mark the checkbox next to the items to reset.
4. Click Delete.
5. Click Yes on the confirmation screen that appears. The items you marked to reset are removed from the

list.
6. To view the changes to the database, select Exit and Sign Out and then re-open the program.

Note: We strongly recommend that you make a backup of your database before resetting the registry. For 
information about creating a backup, see the Database Administration Guide.
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